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Chapter 1 — General Information

1-1 Introduction
The Spectrum Master User Guide is part of a set of manuals that cover all of the instrument 
functions and their use. This manual covers the instrument overview, system functions, and 
other common features, along with a brief guide to basic measurement concepts and setups. 
Most instrument operations and modes are covered in specific measurement guides as listed 
below.

Additional Documentation  

Document Part Number Description (Required Option)

10100-00065 Important Product Information, Compliance, and Safety Notices

10580-00349

Spectrum Analyzer Measurement Guide
PIM Hunting
Spectrum Analyzer (Option 709, 713, 720, 732, or 743)
IQ Waveform Capture (Option 24)
Interference Analyzer (Option 25)
Channel Scanner (Option 27)
Zero-Span IF Output (Option 89)
Gated Sweep (Option 90)
Coverage Mapping (Option 431)
EMF Measurements (Option 444)
AM/FM/PM Analyzer (Option 509)

10580-00234

3GPP Signal Analyzer Measurement Guide
GSM/GPRS/EDGE Measurements (Option 880)
W-CDMA/HSPA+ Measurements (Option 881)
TD-SCDMA/HSPA+ Measurements (Option 882)
LTE/LTE-A FDD/TDD Measurements (Option 883)
LTE 256 QAM Demodulation Measurement (Option 886)
NB-IoT Measurements (Option 887)

10580-00235
3GPP2 Signal Analyzer Measurement Guide
CDMA/EV-DO Measurements (Option 884)

10580-00236
WiMAX Signal Analyzer Measurement Guide
WiMAX Fixed/Mobile Measurements (Option 885)

10580-00240
Power Meter Measurement Guide
High Accuracy Power Meter (Option 19)

10580-00339
Tracking Generator Measurement Guide
Tracking Generator (Option 809, 813, or 820)

10580-00341 SCPI Programming Manual

10580-00455 EMF Measurement Guide (Option 444)

11410-00646 Spectrum Master MS2720T Technical Data Sheet
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Read the Handheld Instruments Product Information, Compliance, and Safety Guide 
(PN: 10100-00065) for important safety, legal, and regulatory notices before operating the 
equipment. For additional information and literature covering your product, visit the product 
page of your instrument and select the Library tab:

http://www.anritsu.com/en-US/test-measurement/products/ms2720t 

Contacting Anritsu for Sales and Service 

To contact Anritsu, visit the following URL and select the services in your region:

http://www.anritsu.com/contact-us 

1-2 Instrument Description
The Spectrum Master is a synthesizer-based handheld spectrum analyzer that provides quick 
and accurate measurement results. The instrument is designed for monitoring, measuring, 
and analyzing signal environments. Measurements can easily be made by using the main 
instrument functions: frequency, span, amplitude, and bandwidth. Dedicated keys for 
common functions and a familiar calculator-type keypad are available for fast data entry.

Typical measurements include: in-band interference and transmit spectrum analysis, plus 
cell site and 802.11a/b/g interference testing. Options are available for RF, advanced 
demodulation, and over-the-air (OTA) measurement. A full range of marker capabilities (such 
as peak, center, and delta functions) are provided for faster, more comprehensive analysis of 
displayed signals. Upper and lower multi-segmented limit lines are available to create quick, 
simple pass/fail measurements. A menu option provides for an audible alert when a limit 
value is exceeded.

The bright daylight-viewable, high-resolution, color liquid crystal display (LCD) provides 
easy viewing in a variety of lighting conditions. The Spectrum Master is capable of up to 
3 hours of continuous operation from a fully charged battery and can be operated from a 
12 VDC source, which simultaneously charges the battery.

The combination of a touch screen and keypad enables users to navigate menus with the 
touch screen and enter numbers with the keypad.

Time and date stamping of measurement data is automatic. The internal memory provides 
for the storage and recall of up to 1000 measurement setups and up to 1000 traces. 
Measurements and setups can be stored in a USB memory device or transferred to a PC by 
using the included USB cable.

Note

Not all after-market USB drives are compatible with the Spectrum Master. Many 
drives come with a second partition that contains proprietary firmware. This 
partition must be removed. Only one partition is allowed. Refer to the individual 
manufacturer for instructions on how to remove it. You may also try reformatting a 
drive that contains a single partition using FAT32 format.

http://www.anritsu.com/contact-us
http://www.anritsu.com/en-US/test-measurement/products/ms2720t
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Available Models

Table 1-1 lists the frequency options available with the Spectrum Master MS2720T. 

Table 1-1. Spectrum Master Frequency Options

Model  Frequency Range

MS2720T-0709 Spectrum Analyzer, 9 kHz to 9 GHz

MS2720T-0713 Spectrum Analyzer, 9 kHz to 13 GHz

MS2720T-0720 Spectrum Analyzer, 9 kHz to 20 GHz

MS2720T-0732 Spectrum Analyzer, 9 kHz to 32 GHz

MS2720T-0743 Spectrum Analyzer, 9 kHz to 43 GHz

MS2720T-0809 9 GHz Tracking Generatora

a. Tracking Generator frequency must match instrument hardware frequency option. For example, 
MS2720T-0813 is an option for MS2720T-0713.

MS2720T-0813 13 GHz Tracking Generatora

MS2720T-0820 20 GHz Tracking Generatora
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Available Options

Available options for the Spectrum Master are listed in Table 1-2. 

Table 1-2. Available Options

Option Description

MS2720T-0007 Secure Data Operation

MS2720T-0009 I/Q Demodulation Hardware

MS2720T-0019 High Accuracy Power Meter (requires USB Power Sensor)

MS2720T-0024 I/Q Waveform Capture (requires Option 9)

MS2720T-0025 Interference Analyzer (Option 31 recommended)

MS2720T-0027 Channel Scanner

MS2720T-0031 GPS Receiver (requires GPS Antenna) 

MS2720T-0089 Zero-Span IF Output

MS2720T-0090 Gated Sweep

MS2720T-0431 Coverage Mapping (requires Option 31 for full functionality)

MS2720T-0444 EMF Measurements (requires Anritsu Isotropic Antenna)

MS2720T-0509 AM/FM/PM Measurements (requires Option 431 for full functionality)

MS2720T-0880 GSM/GPRS/EDGE Measurements (requires Option 9)

MS2720T-0881 W-CDMA/HSPA+ Measurements (requires Option 9, Option 31 
recommended)

MS2720T-0882 TD-SCDMA/HSPA+ Measurements (requires Option 9, Option 31 required 
for full functionality)

MS2720T-0883 LTE/LTE-A FDD/TDD Measurements (requires Option 9, Option 31 
required for full functionality)

MS2720T-0886 LTE 256 QAM Demodulation Measurements (requires Option 883)

MS2720T-0887 NB-IoT Measurements (requires Option 9)

MS2720T-0884 CDMA/EV-DO Measurements (requires Option 9, Option 31 required for 
full functionality)

MS2720T-0885 WiMAX Fixed/Mobile Measurements (requires Option 9, Option 31 
required for full functionality)

MS2720T-0098 Standard Calibration to ISO17025 and ANSI/NCSL Z540-1. Includes 
calibration certificate.

MS2720T-0099 Premium Calibration to ISO17025 and ANSI/NCSL Z540-1. Includes 
calibration certificate, test report, and uncertainty data.
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1-3 Calibration and Verification 
Anritsu recommends annual calibration and performance verification by local Anritsu service 
centers. The Spectrum Master is self-calibrating and there are no field-adjustable 
components. Contact information for Anritsu Service Centers is available at: 
http://www.anritsu.com/contact-us.

1-4 Instrument Care and Preventive Maintenance
Instrument care and preventive maintenance consist of cleaning the unit and inspecting and 
cleaning the RF connectors and all accessories. Clean the instrument with a soft, lint-free 
cloth dampened with water or water and a mild cleaning solution. 

Connector Care

Clean the RF connectors and center pins with a cotton swab dampened with denatured 
alcohol. Visually inspect the connectors. The fingers of the N(f) connectors and the pins of the 
N(m) connectors should be unbroken and uniform in appearance. If you are unsure whether 
the connectors are undamaged, gauge the connectors to confirm that the dimensions are 
correct. Visually inspect the test port cable(s). The test port cable should be uniform in 
appearance, and not stretched, kinked, dented, or broken.

To prevent damage to your instrument, do not use pliers or a plain wrench to tighten the 
Type-N connectors. The recommended torque is 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m). 
Inadequate torque settings can affect measurement accuracy. Over-tightening connectors can 
damage the cable, the connector, the instrument, or all of these items.

Visually inspect connectors for general wear, cleanliness, and for damage such as bent pins or 
connector rings. Repair or replace damaged connectors immediately. Dirty connectors can 
limit the accuracy of your measurements. Damaged connectors can harm the instrument. 
Connection of cables carrying an electrostatic potential, excess power, or excess voltage can 
damage the connector, the instrument, or both.

Connecting Procedure

1. Carefully align the connectors. The male connector center pin must slip concentrically 
into the contact fingers of the female connector.

2. Push connectors straight together. Do not twist or screw them together. A slight 
resistance can usually be felt as the center conductors mate.

3. To tighten, turn the connector nut, not the connector body. Major damage can occur to 
the center conductor and to the outer conductor if the connector body is twisted.

4. If you use a torque wrench, initially tighten by hand so that approximately 1/8 turn or 
45 degrees of rotation remains for the final tightening with the torque wrench.

Relieve any side pressure on the connection (such as from long or heavy cables) in order 
to assure consistent torque. Use an open-end wrench to keep the connector body from 
turning while tightening with the torque wrench.

Do not over-torque the connector.

Caution To avoid damaging the display or case, do not use solvents or abrasive cleaners.

http://www.anritsu.com/contact-us
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Disconnecting Procedure

1. If a wrench is needed, use an open-end wrench to keep the connector body from turning 
while loosening with a second wrench.

2. Complete the disconnection by hand, turning only the connector nut.

3. Pull the connectors straight apart without twisting or bending.

ESD Caution

The Spectrum Master, like other high performance instruments, is susceptible to electrostatic 
discharge (ESD) damage. Coaxial cables and antennas often build up a static charge, which 
(if allowed to discharge by connecting directly to the instrument without discharging the 
static charge) may damage the Spectrum Master input circuitry. Instrument operators must 
be aware of the potential for ESD damage and take all necessary precautions.

Operators should exercise practices outlined within industry standards such as JEDEC-625 
(EIA-625), MIL-HDBK-263, and MIL-STD-1686, which pertain to ESD and ESDS devices, 
equipment, and practices. Because these apply to the Spectrum Master, it is recommended 
that any static charges that may be present be dissipated before connecting coaxial cables or 
antennas to the instrument. This may be as simple as temporarily attaching a short or load 
device to the cable or antenna prior to attaching to the Spectrum Master. It is important to 
remember that the operator may also carry a static charge that can cause damage. Following 
the practices outlined in the above standards will ensure a safe environment for both 
personnel and equipment.

RF Input Warning

The Anritsu Spectrum Master is a sensitive measuring instrument designed to measure low 
power levels. Avoid damaging this sensitive circuitry by observing the maximum input levels 
printed on the instrument connector labeling and specified in the product technical data 
sheet. 

Typical maximum input is +23 dBm (±50 VDC) and could be less if additional features, such 
as a preamplifier, are in use. Be sure to review the product technical data sheet or Anritsu 
website for recommended components and accessories that can help you protect your 
instrument. These include a variety of adapters, attenuators, filters, and RF power detection 
accessories.
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Battery Replacement

The battery can be replaced without the use of tools. The battery compartment door is located 
on the lower left side of the instrument (when you are facing the measurement display). To 
remove the battery:

1. Push down on the battery door tab to disengage it.

2. Remove the battery door.

3. Pull straight out on the lanyard to remove the battery pack from the instrument.  

Note
When inserting the battery, the battery label should face up and the end where the 
battery contacts are located slides in first. If the battery door does not close tightly, 
the battery may be inserted incorrectly.

Figure 1-1. Battery Compartment Door 

Battery
Compartment
Door

nt
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The battery that is supplied with the Spectrum Master may need charging before use. The 
battery can be charged while it is installed in the Spectrum Master by using either the 
AC-DC Adapter, or outside the Spectrum Master with the optional Dual Battery Charger. 
Refer to “Symbols and Indicators” on page 2-12 for a description of battery symbols. 

Note

Use only Anritsu Company approved batteries, adapters, and chargers with this 
instrument. Anritsu recommends removing the battery for long-term storage of the 
instrument.

To ensure an improved battery life, do not charge the battery above 40ºC. 
Press Shift+8 > Status to view the Battery Temperature in the Status window. 

If the battery temperature exceeds the limit, disconnect the AC power supply and 
allow it to cool down and perform a power cycle before resuming operation.

Caution

When using the Automotive Power Adapter, always verify that the supply is rated 
for a minimum of 60 Watts @ 12 VDC, and that the socket is clear of any dirt or 
debris. If the adapter plug becomes hot to the touch during operation, discontinue 
use immediately.
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Chapter 2 — Instrument Overview

2-1 Introduction
This chapter provides an overview of the Anritsu Spectrum Master. It describes the 
instrument front panel, touch screen display, and the connector panel. For detailed 
information on the instrument’s test and measurement functions, refer to one of the Anritsu 
user documents listed in Appendix A, “Related Documents”.

2-2 Turning On the Spectrum Master
The Anritsu Spectrum Master is capable of approximately three hours of continuous 
operation from a fully charged, field-replaceable battery (refer to “Battery Replacement” 
on page 1-7). The instrument can also be operated from a 12 VDC source (which will 
simultaneously charge the battery). This can be achieved with either the Anritsu AC-DC 
Adapter or the Automotive Power Adapter. Both items are included as standard accessories 
with the Spectrum Master. Refer to the instrument Technical Data Sheet. 

To turn on the MS2720T, press the green On/Off button on the front panel (see Figure 2-1 
on page 2-2).

The Spectrum Master takes approximately 60 seconds to complete power-up and to load the 
application software. At the completion of this process, the instrument is ready for use. 

Caution 

When using the Automotive Power Adapter, always verify that the supply is rated 
for a minimum of 60 Watts @ 12 VDC, and that the socket is clear of any dirt or 
debris. If the adapter plug becomes hot to the touch during operation, discontinue 
use immediately.

Note
Keep the fan inlet and exhaust ports clear of obstructions at all times for proper 
ventilation and cooling of the instrument.
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2-3 Instrument Front Panel
The Spectrum Master uses a touch screen and keypad for data input. The five bottom menu 
keys and up to eight submenu keys on the right side of the display are touch screen keys. The 
menu and submenu keys vary depending on the current measurement mode, installed 
options, and instrument function selected.  

Figure 2-1. Front Panel Overview

1. Connector Panel

2. Fan Exhaust Port

3. Submenu Keys (Active Menu or Active Function Block)

4. Menu Button

5. Power LED and Battery Charge LED

6. On/Off Button

7. Enter Key and Arrow Keys

8. Rotary Knob

9. Number Keypad (includes Shift and Esc)

10. Fan Inlet Port

11. Measurement Display or Sweep Window

12. Main Menu Keys

13. Fan Exhaust Port

1 3
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9

8

2
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LED Indicators

Power LED

The Power LED is located on the left of the On/Off button. The LED is solid green when the 
instrument is on, and blinks slowly when the unit is off but is connected to an external power 
source.

Charge LED

The Charge LED is located on the right of the On/Off button. The LED blinks slowly when the 
battery is charging and is solid green when the battery is fully charged.

Front Panel Keys   

The numeric keypad, rotary knob, and the four arrow keys can all be used to change the value 
of the currently selected parameter.

Numeric Keypad

Keys 0 through 9 are used for numeric input, with an alternate function printed in blue above 
each of the keys. Press the Shift key, then a numeric key, to access the instrument menu or 
function indicated by the key label.

Some of the alternate functions associated with the numeric keypad are not available in all 
measurement modes. Refer to the Measurement Guides listed in Appendix A.

Shift Key

Pressing the Shift key followed by a number key executes the function that is indicated in 
blue above the number key. When the Shift key is active, its icon is displayed at the far right 
of the title bar, above the sweep window. 

Esc Key

Press this key to cancel the parameter change being made and exit the current menu 
function, if applicable.

Arrow Keys

The four arrow keys are used to scroll through a list and highlight the item you wish to select, 
or to change the value of the currently selected parameter. The arrow keys can also be used to 
move markers. The rotary knob performs similar functions.

Enter Key

Press this key to apply a parameter value or instrument setting you have entered, or to select 
a highlighted item from a list.

Figure 2-2. Shift Key Icon in Title Bar
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Rotary Knob

Turn the rotary knob to change numerical values, scroll through selectable items in a list, or 
to move markers. Values or items may be within a dialog box or an edit window.

Menu Key

The Menu key displays a grid of shortcut icons for installed measurement modes and 
user-selected menus and setup files. See Figure 2-3. Press one of the icons in the top three 
rows to change modes. These icons are preinstalled and cannot be moved or deleted.

An alternative to the Menu key is to press Shift, then the Mode (9) key to display the Mode 
Selector list box. Refer to “Mode Selector” on page 2-18.  

Figure 2-3. Menu Key Screen

Note
Shortcut icons displayed in the top rows of the Menu screen vary with the 
instrument model, firmware version, and installed options. Help for the Menu 
screen is available by pressing the icon in the lower-right corner of the display.
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User-Created Shortcuts

To create a shortcut to any submenu key or main menu key, press and hold the key until a 
grid appears, showing the open locations on the Menu screen where you can place the new 
shortcut. Press one of the cells in the displayed grid to place the shortcut. See Figure 2-4. 

To create a shortcut to a setup file (.stp), press Recall under the File menu, then press and 
hold the desired file name until a grid is displayed. Select the display location of the new 
shortcut as described above.

User-defined shortcuts remain on the Menu screen until deleted. To delete or move a shortcut 
icon, press the Menu key, then press and hold the shortcut until the Customize Button dialog 
appears. See Figure 2-5. Press the appropriate button to delete or move the shortcut icon. 

Press Esc to close the dialog without deleting or moving the shortcut. Also use Esc to exit the 
Menu screen.

Figure 2-4. Placement Grid for User-Created Shortcuts

Figure 2-5. Customize Button Dialog
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2-4 Connector Panel  
Figure 2-6 shows the connector panel on the MS2720T with lower frequency options (up to 
20 GHz), which also have the Tracking Generator option available.  

Figure 2-6. Test Panel Connectors for MS2720TOptions 709, 713, 720

1. External Trigger In Connector

2. External Reference In Connector

3. Fan Exhaust Port

4. Spectrum Analyzer RF In Port, Type N Connector

5. Location for Optional Tracking Generator RF Out, Type N Connector

6. External Power Connector

7. LAN Connection

8. USB Interface, Type A

9. USB Interface, Type Mini-B

10. Headset Jack

11. Reference Out Connector, 10 MHz

12. IF Out Connector, 140 MHz (Option 89)

13. GPS Antenna Connector

1 3

79 8

2 54

6101213 11
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The connector panel shown in Figure 2-7 is for the two higher frequency options (32 GHz and 
43 GHz).  

Ext Trigger  In

A TTL signal that is applied to the External Trigger 50 female BNC input connector causes 
a single sweep to occur. In the Spectrum Analyzer mode, it is used in zero span, and 
triggering occurs on the rising edge of the signal. After the sweep is complete, the resultant 
trace is displayed until the next trigger signal arrives.

Ext Ref In  

The External Reference In port is a 50  BNC female connector that provides for input of an 
external frequency reference. Refer to your technical data sheet for valid frequencies and 
input levels. To prevent damage to your instrument, do not use pliers or a wrench to tighten 
the BNC connector or overpower the input.

Figure 2-7. Test Panel Connectors for MS2720TOptions 732, 743

1. External Trigger In Connector

2. External Reference In Connector

3. Fan Exhaust Port

4. Spectrum Analyzer RF In Port, Ruggedized Type K Connector

5. External Power Connector

6. LAN Connection

7. USB Interface, Type A

8. USB Interface, Type Mini-B

9. Headset Jack

10. Reference Out Connector, 10 MHz

11. IF Out Connector, 140 MHz (Option 89)

12. GPS Antenna Connector

1 3

68 7

2 4

591112 10
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RF In  

MS2720T-0709, MS2720T-0713, MS2720T-0720: Type N(f), 50 Ω connector. The 
recommended torque is 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m).

MS2720T-0732, MS2720T-0743: Type K(f), 50 Ω ruggedized connector. The recommended 
torque is 8 lbf·in (0.9 N·m or 90 N·cm).

Tracking Generator RF Out 

This is a 50  Type N female connector (MS2720T-0809, MS2720T-0813, MS2720T-0820). To 
prevent damage to your instrument, do not use pliers or a plain wrench to tighten the Type-N 
connector. The recommended torque is 12 lbf·in to 15 lbf·in (1.36 N·m to 1.70 N·m).

External Power  

This is a 2.1 mm by 5.5 mm barrel connector, 12 to 15 VDC, < 5.0 A. The external power 
connector is used to power the unit and for battery charging. A green blinking LED near the 
Power button indicates that the instrument battery is being charged by the external charging 
unit. The indicator is a steady green when the battery is fully charged. 

Refer to “External Power On” on page 3-11 and “Power-On Menu” on page 5-6 when 
controlling the Spectrum Master via external power.

LAN Connection 

The RJ-45 connector is used to connect the Spectrum Master to a local area network or 
directly to a PC with an Ethernet crossover cable. Integrated into this connector are two 
LEDs. The amber LED shows the presence of a 10 Mbit/s LAN connection when on, and a 
100 Mbit/s LAN connection when off. The green LED flashes to show that LAN traffic is 
present. For more information on the LAN connection, Ethernet connection, and DHCP, refer 
to Chapter 8 and Appendix D, “LAN and DHCP”.

USB Interface – Type A 

The Spectrum Master has two Type A USB connectors that accept USB Flash Memory 
devices for storing measurements, setup data, and screen images.

Warning

To prevent damage to your instrument, do not use pliers or a plain wrench to 
tighten the connector. Do not overtighten the connector. Do not overpower the 
RF Input. Refer to your technical data sheet for valid frequencies and input 
levels. Typical maximum input is +23 dBm (±50 VDC).

Warning

When using the AC-DC Adapter, always use a three-wire power cable that is 
connected to a three-wire power line outlet. If power is supplied without grounding 
the equipment in this manner, the user is at risk of receiving a severe or fatal 
electric shock.
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USB Interface – Type Mini-B  

The 5-pin mini-B USB 2.0 interface can be used to connect the Spectrum Master directly to a 
PC. The first time the MS2720T is connected to a PC, the normal USB device detection by the 
computer operating system will take place. A Windows driver is installed when Master 
Software Tools is installed. Drivers are available for versions of the Windows XP operating 
system and later. During the driver installation process, specify that the installation wizard 
should search the Master Software Tools directory for the driver. 

Headset Jack  

The 3-wire headset jack provides audio output from the built-in AM/FM/SSB demodulator 
and from other sounds generated by the instrument. The jack accepts a 3.5 mm 3-wire 
miniature phone plug such as those commonly used with cellular telephones.

Ref Out 10 MHz

The External Reference Out port is a 50  BNC female connector that provides 10 MHz at 
approximately –7 dBm to 0 dBm. To prevent damage to your instrument, do not use pliers or 
a wrench to tighten the BNC connector.

IF Out 140 MHz (Option 89) 

This 50  BNC female connector is for Zero Span 140 MHz IF Output with Option 89. To 
prevent damage to your instrument, do not use pliers or a wrench to tighten the BNC 
connector.

GPS Antenna Connector (Option 31)   

The GPS antenna connection on the Spectrum Master is type SMA-female. GPS function is 
described in Chapter 6.

Note
For proper detection, Master Software Tools should be installed on the PC prior to 
connecting the Spectrum Master to the USB port.



2-5 Interface Screen Instrument Overview

2-10 PN: 10580-00340  Rev. R MS2720T UG

2-5 Interface Screen
Figure 2-8 illustrates the Spectrum Master interface screen in Spectrum Analyzer mode, with 
touch screen menu keys, title bar, and measurement settings and results around the graph 
area, or sweep window.   

Figure 2-8. Spectrum Analyzer Display

1. Real Time Clock (and Latitude and Longitude with GPS)

2. Data Summary, Active Marker Values

3. Measurement Display or Measurement Grid or Sweep Window

4. Battery Charge Indicator

5. Instrument Mode

6. Submenu Key Labels or Active Function Block

7. Main Menu Key Labels

8. Optional Data Window (also location of Marker Table)

9. Instrument Settings Summary
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Touch Screen Keys

Main Menu Touch Screen Keys

There are five main menu keys horizontally arranged along the bottom of the interface 
screen. These keys give access to the instrument’s test and measurement functions, which are 
documented in the applicable Measurement Guide. Refer to Appendix A, “Related 
Documents”.

Different operation or measurement modes may display different main menu keys. To switch 
to another mode, press the Menu key, or press Shift followed by the Mode (9) key. 

Submenu Touch Screen Keys

Most of the instrument setup, control, and measurement functions are performed through the 
use of the submenu keys along the right side of the display. The key labels change as 
measurement settings and instrument setup parameters change. The current submenu title 
is displayed at the top of the submenu key block, which consists of up to eight touch screen 
keys. See Figure 2-8 on page 2-10.

Symbols and Icons on the Title Bar 

The instrument title bar displays the system date and time. When GPS is on and is tracking 
satellites, its icon is followed by latitude and longitude coordinates.

Press the storage icon to open the touch screen keyboard for saving measurements, setups, 
limit lines, or screen display JPEG files. This shortcut to the “Save Menu” on page 4-12 is 
equivalent to pressing Shift and File (7), then Save. Refer to “Save Dialog Box” on page 4-3.

Press the camera icon to save a JPEG image of the current screen display.

The battery symbol indicates the charge remaining in the battery. The colored section inside 
the symbol changes size and color with the charge level. See Table 2-1 on page 2-12. The 
Battery Charge LED (adjacent to the On/Off button) flashes when the battery is charging, 
and remains on steady when the battery is fully charged. 

The Shift icon is displayed when the Shift key is pressed, and it remains displayed until 
another button is pressed.

Note
Many of the measurement settings displayed to the left and the top of the sweep 
window are touch screen shortcuts to the corresponding menus.

Note
The installed options determine what measurement modes are available. Refer to 
Table 1-2 on page 1-4.

Figure 2-9. Title Bar with Icons

Caution 
Use only Anritsu-approved batteries, adapters, and chargers with this instrument. 
Anritsu recommends removing the battery for long-term storage of the instrument.
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Symbols and Indicators

The following symbols, icons, and indicators convey the instrument status or condition on the 
display. The colors shown here are in the standard or default display mode. 

Table 2-1. Symbols and Icons

Symbol Description

Green: Battery is 30% to 100% charged.   

Yellow: Battery is 10% to 30% charged.

Red: Battery 0% to 10% charged.

Green with Black Plug body: Battery is fully charged and 
external power is applied.

Lightning Bolt: Battery is being charged (any color symbol).

Red Plug body: External power is applied, and no battery is 
installed, or battery has lost communications with the instrument.

Storage Icon: Tap the floppy disk icon to display the Save screen 
and menu.    

Camera Icon: Saves a JPEG image of the current screen display.     

Shift Key Icon: This icon is displayed between the battery symbol 
and the submenu keys after the Shift key has been pressed, and 
until another key is pressed. 

GPS Icon: This icon is displayed right after the date and time 
when GPS is available. Refer to Chapter 6, “GPS (Option 31)” for 
details.

Power Button with Power LED and Charge LED: This is a 
physical button with LED indicators. It is located near the numeric 
keypad.

Shift
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Display Settings

The Display Settings submenu lets you adjust the screen brightness level and control the 
auto-dimming function. Refer to “Brightness Settings Menu” on page 5-8.

You can also turn off the display entirely, as described in “Display Settings Menu” 
on page 5-7. To turn the display back on, press any key (except the Power button) three times 
in rapid succession.

In addition to the default display colors shown in Figure 2-8 on page 2-10, you can select 
different color schemes to suit the ambient lighting conditions. See Figure 2-10. Some color 
settings may not be available in all measurement modes.

Black on White — used for printing and viewing in broad daylight conditions

Night Vision — optimized for nighttime viewing

High Contrast — used in challenging viewing conditions

Color on White — used for printing and viewing in broad daylight conditions

Figure 2-10. Spectrum Master Display Color Settings

Black on White Night Vision

Color on WhiteHigh Contrast
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Touch Screen Calibration

Calibration optimizes the response of touch input. It is recommended if the instrument does 
not respond as expected when you press the touch screen.

The Calibrate Touch Screen submenu key is in the “System Menu” on page 5-3. When pressed, 
a message box is displayed with instructions for calibration. See Figure 2-11. Press Enter to 
begin calibration, or press Esc to cancel. Alternatively, you can press 1 while the message box 
is displayed to use the arrow keys for navigation. Refer to “Disable Touch Screen to Use 
Arrow Navigation”. 

During calibration, press the crosshairs in sequence as they appear on the screen. The 
process takes less than one minute.

Calibrate Touch Screen Shortcut

Another way to access touch screen calibration is to press Shift, then 0 (zero). This displays 
the touch screen calibration message box shown in Figure 2-11. The shortcut can be used if 
your touch inputs do not correspond to the appropriate locations on the screen to such an 
extent that you cannot access the Calibrate Touch Screen submenu key.

Disable Touch Screen to Use Arrow Navigation

If the touch screen is not functioning, you can use Arrow Navigation to simulate pressing the 
touch screen main menu keys and submenu keys. From the touch screen calibration message 
box (see Figure 2-11), press 1 to display the arrow navigation message box, illustrated in 
Figure 2-12. Press 1 again to enter the arrow navigation mode, or press Esc to cancel. 

In arrow navigation mode, a red border highlights the currently selected key (see Figure 2-13 
on page 2-15). Use the arrow keys to move the red selection box, then press the Menu key to 
activate the highlighted key. Only the main menu keys and submenu keys can be activated 
using Arrow Navigation. This feature does not move the red selection box into other areas of 
the touch screen, like the display title bar, sweep window, or the instrument settings area on 
the left.

Figure 2-11. Touch Screen Calibration Message Box

Figure 2-12. Arrow Navigation Message Box
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To save a measurement in arrow navigation mode, press Shift then File (7). Use the arrow 
keys to move the red selection box to the Save Measurement As submenu key. This submenu 
key must be used because the arrow navigation mode cannot be used to change data in popup 
windows in the measurement display. File names are determined by the current setting of the 
Save Measurement As submenu key. Refer to “Save Measurement As” on page 4-11.

You can save a JPEG image of the current display screen by pressing Shift, followed by 
Decimal, then +/–. The JEPG image shows screen data, but does not contain the additional 
measurement information that accompanies a saved measurement in a *.spa measurement 
file.

To return to normal touch entry mode, reboot the instrument (turn power Off, then On). If 
your touch screen has been damaged, refer to “Contacting Anritsu for Sales and Service” 
on page 1-2. 

Figure 2-13. Arrow Navigation Example
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2-6 Data Entry
User input can be in the form of numeric values for instrument or measurement settings, 
selected values from a preset list, or alphanumeric text when entering file names, for 
example. To view or change a parameter value, access the appropriate submenu by pressing 
one of the five main menu keys along the bottom of the interface screen, then navigating 
through the touch screen submenus.

Other instrument functions are accessible from the numeric keypad, when used in 
combination with the Shift key. Refer to “Numeric Keypad” on page 2-3. Some of the 
parameter settings displayed on the left of the interface screen or under the title bar are 
touch screen shortcuts to related submenus.

Depending on the measurement mode, refer to the associated Measurement Guide listed in 
Appendix A for a description of available menus and submenus.

Numeric Values

To modify a numeric parameter setting that is displayed on a submenu touch screen key, 
press the key to make it active. The display color of the currently set value changes to red. 
Use the rotary knob, arrow keys, or the numeric keypad to change the value. When entering a 
value from the keypad, the submenu typically shows the selectable units. Press the desired 
unit or press Enter to complete the entry.

Selection Lists

Some parameters and instrument functions are selectable from a pop-up list. These list boxes 
display the available selections, and value limits if applicable. Use the arrow keys or the 
rotary knob to scroll through the list and highlight the desired entry. You can also use the 
touch screen to make your selection.

To apply the selection, press Enter. To exit the selection list without making a change, press 
the Escape (Esc) key.
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Text Entry 

When an instrument function requires you to enter text, such as a name for a measurement 
or setup file you wish to save, a touch screen keyboard is displayed. See Figure 2-14. Digits 
can be entered using the touch screen keyboard or the front panel keypad. The left and right 
arrow keys move the insertion point in the file name edit box.

Refer to “Save Dialog Box” on page 4-3 for information on saving files.

Figure 2-14. Touch Screen Keyboard
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2-7 Mode Selector
To change to another application or measurement mode, press Shift, then the Mode (9) key to 
display the Mode Selector list box, illustrated in Figure 2-15. Use the directional arrow keys 
or the rotary knob to highlight the desired mode, then press Enter to switch to the selected 
application. The measurement modes available for selection depend on the options that are 
installed and activated on your instrument.

An alternate method of selecting a measurement mode is through the use of the “Menu Key” 
on page 2-4. 

Figure 2-15. Mode Selector List Box
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2-8 Soft Carrying Case
The instrument can be operated while in the soft carrying case. On the back of the case is a 
storage pouch for accessories and supplies. Inside the pouch is a D-ring that can be used to 
securely attach a small accessory.

To install the instrument into the soft carrying case:

1. The front panel of the case is secured with hook-and-loop fasteners. Fully close the front 
panel of the case. When closed, the front panel supports the shape of the case while you 
are inserting the Spectrum Master.

2. Place the soft carrying case face down on a stable surface, with the front panel fully 
closed and laying flat.

3. Fully open the zippered back of the case. 

Note

Two zippers provide access around the back of the case. The zipper closer to the 
front of the case opens the case back, and allows access to install and remove the 
instrument. The zipper closer to the back of the case opens a support panel that 
can be used to provide support for improved stability and air flow while the 
instrument is in the case. The support panel angle is adjustable. This support 
panel also contains the storage pouch.
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4. Insert the instrument face down into the case, taking care that the connectors are 
properly situated in the case top opening. You may find it easier to insert the 
connectors first, then pull the corners over the bottom of the Spectrum Master. 

5. Close the back panel and secure with the zipper. 

The soft carrying case includes a detachable shoulder strap, which can be connected to the 
D-rings on the corners of the case, as required for comfort or convenience. Using one upper 
corner and one lower corner holds the bottom of the instrument close to your chest and allows 
hands-free operation.

2-9 Tilt Bail Stand   
The attached tilt bail can be used for desktop operation when the instrument is not installed 
in the soft case. The tilt bail provides a backward tilt for improved stability and air flow. To 
deploy the tilt bail, pull the bottom of the tilt bail away from the back of the instrument. To 
store the tilt bail, push the bottom of the bail towards the back of the instrument and snap 
the bail into the clip on the back of the instrument.

Figure 2-16. Soft Carrying Case
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Chapter 3 — Initial Startup

3-1 Introduction
This chapter gives a brief overview of the Anritsu MS2720T Spectrum Master and is intended 
to assist you in your first use of the instrument. The purpose of this chapter is to provide a 
starting point for making basic measurement setups. This chapter describes general 
instrument setup, including: instrument mode, frequency, bandwidth, amplitude, span, limit 
lines, and markers. After measurements are taken, refer to “Managing Files” on page 4-1 for 
a description of saving, recalling, and deleting measurement files. For more detailed 
information about specific measurements, refer to the measurement descriptions in the 
measurement guides for the specific instrument mode and analyzer technology (such as 
Spectrum Analyzer, WiMAX, or 3GPP). Refer to Appendix A, “Related Documents”, for a list of 
these measurement guides and their Anritsu part numbers.

The Spectrum Analyzer Measurement Guide includes sections that describe resolution 
bandwidth, video bandwidth, sweep, and attenuator functions. For example, in the 
Spectrum Master, Resolution Bandwidth is determined by the intermediate frequency (IF) 
filter bandwidth. The spectrum analyzer traces the shape of the IF filter as it tunes past a 
signal. If more than one IF filter is used in a spectrum analyzer, then the narrowest one 
dominates and is considered the resolution bandwidth. 
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3-2 Measurement Setup

Connect the Input Source

Connect the input signal or antenna to the RF In connector on the top of the instrument. For 
connector descriptions, refer to “Connector Panel” on page 2-6.

Editing and Entering Values

• Parameter values that are ready for editing are displayed in red on the submenu key. 
After changing the value, press Enter to set the new value.

• Some submenu keys have toggled parameter values (On / Off, Low / High, On/Large/Off). 
On these submenu keys, the current value is underlined. Press the submenu key to 
toggle the value.

• Use the Arrow keys, numeric keypad, or rotary knob to change submenu key values or 
to select list box options.

Selecting the Analyzer Mode 

The instrument Analyzer Modes are also referred to as Measurement Modes or Applications. 
To switch to a different mode:

1. Press the Menu button on the instrument front panel.

2. Press the desired screen icon. Refer to “Menu Key” on page 2-4.

Alternatively, you can:

1. Press Shift followed by the Mode (9) key on the numeric keypad to display the Mode 
Selector list of installed applications (refer to “Mode Selector” on page 2-18).

2. Use the directional Arrow keys or the rotary knob to highlight the desired mode. The 
left and right Arrow keys skip to the top and bottom of the list, respectively.

3. Press Enter.

To exit without changing the selection, press Esc.
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3-3 Set the Measurement Frequency  

Using Start and Stop Frequencies 

The frequency settings and the submenu keys are displayed on the left and right edges of the 
graph in the sweep window.

1. Press the Freq main menu key.

2. Press the Start Freq submenu key.

3. Enter the desired start frequency. When entering a frequency by using the keypad, the 
submenu key labels change to frequency units: GHz, MHz, kHz, and Hz. Press the 
appropriate unit key. Pressing the Enter key has the same effect as pressing the MHz 
submenu key.

4. Press the Stop Freq submenu key.

5. Enter the desired stop frequency.

Entering Center Frequency 

1. Press the Freq main menu key.

2. Press the Center Freq submenu key.

3. Enter the desired center frequency using the keypad, the arrow keys, or the rotary knob. 
When entering a frequency by using the keypad, the submenu key labels change to 
frequency units: GHz, MHz, kHz, and Hz. Press the appropriate unit key. Pressing the 
Enter key has the same effect as pressing the MHz submenu key.

The current setting is shown at the top of the instrument settings summary column on the 
left side of the measurement display (see Figure 2-8 on page 2-10).

Selecting Signal Standard   

1. Press the Freq main menu key.

2. Press the Signal Standard submenu key. The Signal Standards list is displayed.

3. Use the rotary knob or press a signal standard on the list to highlight it, then press 
Enter to select.

4. Optionally, press the Channel submenu key to change the channel value in the Channel 
Editor. 

Setting Measurement Frequency Bandwidth   

Spectrum Analyzer and Interference Analysis Mode

1. Press the BW main menu key to display the BW menu.

• Press the RBW or the VBW submenu key (or both) to manually change values.

Note The signal standards list can be updated via Master Software Tools.
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• Set RBW and VBW automatically by pressing the Auto RBW submenu key or the 
Auto VBW submenu key.

2. Press the VBW/Average Type submenu key to toggle between Linear averaging 
(arithmetic mean) and Logarithmic averaging (geometric mean).

3. Press the RBW/VBW submenu key to change the ratio of resolution bandwidth to video 
bandwidth.

4. Press the Span/RBW submenu key to change the ratio of span width to resolution 
bandwidth.

3-4 Set the Amplitude  
Press the Amplitude main menu key to display the Amplitude menu.

Setting Amplitude Reference Level and Scale

Spectrum Analyzer and Interference Analysis Modes

To change the current measurement units, press the Units submenu key and select the 
required units from the submenu keys that are presented. Press the Back submenu key to 
return to the Amplitude menu.

1. Press the Reference Level submenu key and use the Up/Down arrow keys or the keypad 
to change the reference level. Press Enter to set the reference level value. 

2. Press the Scale submenu key and use the Up/Down arrow keys or the keypad to enter 
the desired scale. Press Enter to set the scale value.  

Setting Amplitude Range and Scale

This setting applies to most demodulator modes of instrument operation. The Spectrum 
Analyzer mode has no equivalent to Auto Range. For other analyzer modes, consult the 
individual measurement guides. Refer to Appendix A.

1. Press the Adjust Range submenu key to set an optimal reference level based on the 
measured signal. 

To have the instrument continually set the optimal reference level, press the Auto 
Range submenu key so that On is selected.

2. Press the Scale submenu key.

3. Enter the desired scale units by using the keypad, the Arrow keys, or the rotary knob. 
Press the Enter key to set. The y-axis scale is automatically renumbered.

Note

The Scale parameter cannot be changed when linear units are selected (Watts or 
Volts). 

Press the Amplitude submenu key and select Auto Atten coupling of the attenuator 
setting and the reference level to help ensure that harmonics and spurs are not 
introduced into the measurements. Attenuator Functions are described in the 
Spectrum Analyzer Measurement Guide.
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Reference Level Offset for External Loss or External Gain

To obtain accurate measurements, compensate for any external attenuation or gain by using 
the RL Offset submenu. The compensation factor is in dB. External attenuation can be 
created by using an external cable or an external high power attenuator, external gain is 
typically from an amplifier. 

To adjust the reference level for either gain or loss, press the RL Offset submenu key and 
enter a positive dB value and then press the appropriate submenu key (dB External Gain or 
dB External Loss). The new RL Offset value will be displayed on the instrument and reference 
level is adjusted.

3-5 Set the Span  

Spectrum Analyzer and Interference Analysis Modes

1. Press the Span main menu key or press the Freq main menu key followed by the Span 
submenu key.

2. To select full span, press the Full Span submenu key. Selecting full span overrides any 
previously set Start and Stop frequencies.

3. For a single frequency measurement, press the Zero Span submenu key. 

Note
To quickly move the span value up or down, press the Span Up 1-2-5 or 
Span Down 1-2-5 submenu keys These keys facilitate a zoom-in, zoom-out 
feature in a 1-2-5 sequence. 



3-6 Setting Up Limit Lines Initial Startup

3-6 PN: 10580-00340  Rev. R MS2720T UG

3-6  Setting Up Limit Lines  
Press the Shift key then the Limit (6) key on the numeric keypad to display the Limit menu.

Simple Limit Line

Spectrum Analyzer and Interference Analysis Modes

1. Press the Shift key and then the Limit (6) key. 

2. Press the Limit (Upper / Lower) submenu key to select the desired limit line, Upper or 
Lower.

3. Activate the selected limit line by pressing the On Off submenu key so that On is 
underlined.

4. Press the Limit Move submenu key to display the Limit Move menu. Press the Move Limit 
submenu key to change the dBm level of the limit line.

5. Press the Back submenu key to return to the Limit menu.

6. If necessary, press the Set Default Limit submenu key to redraw the limit line in view.

Limit Line Envelope

Spectrum Analyzer and Interference Analysis Modes 

Using Limit Envelope:

1. Press the Shift key and then the Limit (6) key. 

2. Press the Limit (Upper / Lower) submenu key to select the desired limit line, Upper or 
Lower.

3. Press the Limit Envelope submenu key to display the Limit Envelope menu.

4. Press the Create Envelope submenu key to create an envelope around the measurement.

5. Press Upper Points or Lower Points submenu key to change the number of segments in 
the envelope.

6. Press the Upper Shape or Lower Shape submenu key to toggle between square and 
sloped limit envelope.

7. Adjust the Upper or Lower Offset to move the limit line closer to (a smaller value) or 
further away from the trace.
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Complex Limit Lines

Spectrum Analyzer and Interference Analysis Modes

Figure 3-1 shows an example of a complex limit line. 

When building some complex limit lines, you can create either the right or left half of the limit 
line and then build the remainder by pressing the Limit Advanced submenu key and then 
pressing the Limit Mirror submenu key. The complete set of Limit menus is described in the 
Spectrum Analyzer Measurement Guide (refer to Appendix A).

Figure 3-1. Complex Limit Line Example
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3-7 Setting Up Markers  
Press the Marker main menu key to display the Select Marker box. See Figure 3-3. Touch a 
marker number to activate that marker. After a marker is active, other submenu keys can be 
used to place the marker. Refer to the “Spectrum Analyzer Measurement Guide 
(10580-00349)” for more details.

Selecting, Activating, and Placing a Marker  

1. Press the Marker submenu key to display the Select Marker box. Press the desired 
marker number. The selected marker number is displayed in the sweep window and is 
also underlined on the Marker submenu key.

2. Press the On Off submenu key (if necessary) so that On is underlined. The selected 
marker is displayed in red, ready to be moved.

3. Use the rotary knob, an Arrow key, or the touch screen to place the marker on the 
desired frequency.

Note that when a marker is active, you can drag your finger across the sweep window 
horizontally (at any level) to move the marker. Also, when a marker is active and the 
Marker menu is displayed, you can type a frequency to place the active marker at a 
point of interest.

4. Press the Peak Search submenu key to move the active marker to the highest signal 
amplitude that is currently displayed on screen. For additional marker movements, 
press the More Peak Options submenu key. Refer to the Spectrum Analyzer 
Measurement Guide for more details.

5. Repeat Step 1 and Step 2 to activate and move multiple markers.

Selecting, Activating, and Placing a Delta Marker:    

When a delta marker is On, its position data is relative to its reference marker. For example, 
Delta Marker 3 displays x-axis and y-axis data relative to Marker 3. This reference 
relationship differs when using the “Marker 1 Reference” submenu key as described on 
page 3-10.

1. Press the Marker submenu key and then select a marker in the list box.

2. Press the Delta On Off submenu key so that On is underlined. The selected marker is 
displayed in red, ready to be moved.

3. Use the rotary knob, Arrow keys, touch screen, or the numeric keypad to place the delta 
marker on the desired offset frequency from the associated reference marker.

4. Repeat Step 1 and Step 2 to activate and move multiple delta markers.

Figure 3-2. Marker Selection Box

Select Marker

M1 M2 M3

M4 M5 M6
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Viewing Marker Data in a Table Format 

1. Press the More submenu key.

2. Press the Marker Table submenu key so that On is underlined. All marker data and delta 
marker data are displayed in a table under the measurement graph. If Marker Table is 
set to Large, then the table has room for only the x-axis and y-axis data for one marker, 
which is the active marker. Select another marker to view its values in the large table. 

Marker Table Set to Large    

To change the marker that is displayed in the large marker table, make another marker 
active by selecting it in the Marker Selection box. If you want to make a delta marker active 
without changing its location, first select its reference marker. The Delta submenu key will 
have On underlined, indicating that the delta maker is in use. Press the Delta key once. The 
delta marker will remain On, its position will not change, it will become the active marker, 
and its x-axis and y-axis data will then be displayed in the large Marker Table.

Figure 3-3. Markers with Table
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Marker 1 Reference   

The Marker 1 Reference submenu key is in the Marker (2/2) menu. When turned On, this 
feature sets reference Marker 1 to On, and turns On all six delta markers in positions relative 
to Marker 1. These six positions are spaced evenly across the current measurement span. 

This feature is useful for examining measurement events such as spurs, harmonics, and 
phase noise.

3-8 Selecting a Measurement Type
1. If needed, press the Menu key, then touch the appropriate application screen icon to 

switch measurement mode.

Alternatively, press Shift followed by Mode (9), then select the desired measurement 
mode from the Mode Selector list and press Enter.

2. Press Shift followed by Meas (4), then press one of the measurement type submenu keys 
to select it.

Some measurement modes display a Measurements main menu key on the instrument 
screen. In this case, you can press this key, then one of the submenu keys to select the 
desired measurement type.

3-9 Saving Measurements
1. Press Shift then File (7).

2. Press the Save Measurement submenu key.

3. If needed, press the Filetype field and select Measurement from the drop-down list. 
Alternatively, press the Change Type (Setup/JPG/…) submenu key, then select 
Measurement in the Select File Type dialog and press Enter.

4. Optionally, press the Change Save Location submenu key to change the default location 
where saved files will be stored.

5. Enter the file name using the touch screen keyboard, then press Enter.

Refer to Chapter 4, “File Management” for additional information.

3-10 Software Tools
Anritsu provides is a suite of Microsoft® Windows® compatible software for transferring and 
editing saved measurements, markers, and limit lines to a PC. Refer to Chapter 7, “Anritsu 
Tool Box” for an overview of these products.
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3-11 External Power On  
The When DC Applied setting in the Power-On menu allows the Spectrum Master to restart 
automatically when external DC power is applied to the connector shown as item 5 in 
Figure 2-7 on page 2-7. Refer to “External Power” on page 2-8 and the “Power-On Menu” 
on page 5-6.

When this feature is enabled, the Spectrum Master in the off state will turn on when external 
DC power is applied. The instrument turns off when external power is removed, even if a 
battery is installed. This is useful for high-reliability remote operation, where the instrument 
may need to be rebooted using a remotely-controlled power switch.

If the instrument is turned on with the power switch, then external power is removed, the 
instrument will continue to run until the battery is depleted. It will come on and the battery 
will begin recharging when external power is applied. This state is useful when the 
instrument is in a location where the power source may be interrupted.
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Chapter 4 — File Management

4-1 Introduction
This chapter describes the file management features of the Spectrum Master and the related 
touch screen menus. The File menu and its submenus allow you to save, recall, copy, and 
delete files in internal memory or an external USB flash drive.

4-2 Managing Files 
Press the Shift key, then the File (7) key on the numeric keypad to display the File menu.

File Types  

Under the Save, Recall, Copy, and Delete menus, press the Change Type or the File Type 
submenu key to open the Select File Type list box, where you can select the desired file type.

Available file types depend on the current instrument mode. The Select File Type list box may 
contain the following entries:

• ALL (displays all file types)

• Setup, *.stp 
(Setup files contain basic instrument information, measurement mode setup details, 
measurement marker data, and limit data.)

• Measurement, *.spa, *.ia, *.cs, *.edg, *.wcd, *.tds, *.lte, *.tdlte, 
*.cdma, *.evdo, *.wmxd, *.wmxe, *.afp 
(Measurement files contain all of the information in the setup files and the 
measurement data.)

• JPEG, *.jpg 

• Limit Lines, *.lim 
(The Limit Line file contains limit line data details.)

• Spurious Emission Mask, *.spe 
(The Spurious Emission Mask file contains the frequency, amplitude, and other 
information related to segments in an out-of-band spurious emission mask.)

• KML 2D, *.kml 

• KML 3D, *.kml 

• Mapping Tab Delimited, *.mtd 

You can also use the touch screen to open the drop down list for the Filetype entry box, as 
shown in Figure 4-1 on page 4-2.

Note
When navigating through the File menu, press the Esc key to return to the 
previous menu or submenu. Any changes not yet applied (by pressing Enter) are 
canceled.
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Save Files

The submenu keys that are available for file management may vary with instrument options 
and measurement modes. Refer to “File Menu” on page 4-11.

Save Measurement As

The Save Measurement As submenu key provides a one-touch method of saving the current 
measurement data. The name of the file that will be saved is displayed on the submenu key. 
The numerical suffix increments by 1 following the Save. For example, if the last 
measurement was saved with the file name ACPR, the Save Measurement As shows the 
default file name for the next measurement to be saved as ACPR_1, then ACPR_2, and so on. 
To save using a different file name than the default, press the Save Measurement key or the 
Save key instead of Save Measurement As.

Save Measurement

To save the current measurement data, use the Save Measurement As submenu key described 
above or, to apply a different file name or save location than the default, press the Save 
Measurement submenu key or the Save key. In the Save dialog, you can enter the file name 
and select the type of data to save. See Figure 4-1 and refer to “Save Dialog Box” on page 4-3.

Save

The Save submenu key has the same function as Save Measurement. It opens the Save dialog 
box and menu illustrated in Figure 4-1. 

Figure 4-1. Save Dialog Box
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Save Dialog Box

In the Save dialog, use the touch screen keyboard to enter the name of the file to save. See 
Figure 4-1 on page 4-2. Optionally, you can use the Quick Name keys to insert preset text 
strings into the file name. Refer to “Quick Name Keys”.

To select the type of data to save, either press the Filetype selection box to display the drop 
down list of available file types, or press the Change Type submenu key. Selectable file types 
vary with the measurement mode. Use the Up/Down arrow keys to highlight the desired file 
type, then press Enter to select.

Press Enter again to save the file. File name extensions are automatically assigned based on 
the file type and measurement mode. Refer to “File Types” on page 4-1.

Quick Name Keys

Quick Name keys in the Save dialog provide optional building blocks for entering file names. 
They function as keyboard shortcuts, allowing you to enter predefined, frequently used file 
names or parts of file names. To enter or change a Quick Name, press the Change Quick Name 
submenu key in the Save menu, then select the item to edit (see Figure 4-2) and press Enter 
on the numeric keypad. In the Edit Quick Name dialog, use the touch screen keyboard to 
enter a new Quick Name. See Figure 4-3. Press Enter again and the new name will be 
displayed on the key, in the Save dialog.  

Figure 4-2. Select Quick Name List Box

Figure 4-3. Edit Quick Name Dialog Box
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Quick Name Matrix

The Quick Name Matrix key is present in the Save dialog only in the HIPM measurement 
mode. See Figure 4-4. Similarly to the Quick Name keys, the matrix gives field personnel a 
shortcut method to enter file names in compliance with carrier requirements, which may 
include file naming conventions related to site number, sector information, color coding, 
measurement type, termination device, or frequency information. See Figure 4-5.   

Figure 4-4. Save Dialog Box (HIPM Mode)

Figure 4-5. Quick Name Matrix
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Follow these steps to define and use shortcut keys in the Quick Name Matrix. If all matrix 
keys are already defined, proceed directly to Step 4.

1. To edit any matrix key, press and hold the key until the Edit Quick Name dialog opens. 
See Figure 4-3 on page 4-3.

2. Use the touch screen keyboard to enter a new key label, then press Enter.

3. Repeat the steps above to define more Quick Name Matrix keys, until done.

4. Press the matrix key with the appropriate label to enter the desired text string at the 
insertion point, in the Filename entry box. Press the Esc key to undo. You can use the 
Space and Underscore keys to insert separators in the file name.

5. Repeat Step 4 as needed until the file name is complete.

Note that the Keyboard key (see Figure 4-5 on page 4-4) closes the Quick Name Matrix 
screen and returns to the Save dialog. The next steps can be performed from either 
screen.

6. Select the file type to save, either from the drop down list or by using the Change Type 
submenu key.

7. Optionally, press the Change Save Location submenu key to select a different save 
location.

8. Press Enter to save the file.

Change Save Location

You can save files to internal memory or to an external USB flash drive. To change the 
destination location of the saved file, press the Change Save Location submenu key under the 
Save menu. Figure 4-6 illustrates the directory structure of the instrument’s internal memory 
and external USB drive or drives, if connected. Only folders are listed, not files. 

Figure 4-6. Save Location Screen
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Use the touch screen, the Up/Down arrow keys, or the rotary knob to select a folder from the 
list. To expand a folder and view its subfolders, press Enter or the Right arrow key. Press 
Enter again or the Left arrow key to collapse the folder. To create a new folder, press the 
Create Folder submenu key.

After selecting the folder, press the Set Location key to store the save location. Refer to 
“Save Location Menu” on page 4-13 for a description of the submenu keys.

Save On Event

This menu is not available in all modes of operation. The menu is used to automatically save 
measurement data to the current save location after a selected event type. Refer to 
“Save On... Menu” on page 4-14.
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Recall Files

Press the Recall Measurement key or the Recall key under the File menu to recall a previously 
saved file from internal memory or an external USB drive, if connected. The files listed in the 
Recall dialog box depend on the file type selected. See Figure 4-7. JPEG image files cannot be 
recalled. 

The submenu keys let you change the file types and sort order of the displayed file list. Refer 
to “Recall Menu” on page 4-15.

The Filetype drop down list has the same function as the File Type submenu key. Selectable 
file types vary with the measurement mode. Use the touch screen, rotary knob, or the 
Up/Down arrow keys to select the file you wish to recall, then press Enter.

From the Recall dialog box, you can create a shortcut to a setup file and place the shortcut 
icon on the instrument’s Menu screen. Refer to “User-Created Shortcuts” on page 2-5.

Figure 4-7. Recall Dialog Box
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Copy Files

Press the Copy key under the File menu to open the Copy dialog box and menu, where you 
can copy a single or multiple files or folders. The source and destination locations may be the 
instrument’s internal memory or an external USB drive, if connected. The source files listed 
in the Copy dialog box depend on the chosen file type, which is selected using either the 
Filetype drop down list or the File Type submenu key. You can also change the way folders 
and files are sorted in the displayed list. Refer to “Copy Menu” on page 4-16.

The Filetype drop down list has the same function as the File Type submenu key. Selectable 
file types vary with the measurement mode. Files and folders to copy are listed in the top 
pane of the Copy dialog box. Select the destination in the bottom pane. See Figure 4-8. 

1. To copy to or from an external USB drive, insert the flash drive into a USB port on the 
instrument. Otherwise, skip to the next step.

2. Press the Shift key, followed by File (7), then press the Copy submenu key.

3. Use the submenu keys to select the type of file to copy and the display order of folders 
and files, as appropriate.

4. Make sure the Scroll submenu key is toggled to Src (source).

5. Use the touch screen, rotary knob, or the Up/Down arrow keys to locate and highlight 
(that is, frame) the file or folder you wish to copy. To open a highlighted folder, press 
Enter. Press Enter again or press the Left arrow key to close it.

6. To select a highlighted file or folder for copying, press the Select or De-Select submenu 
key. The selected item is highlighted in blue.

7. If needed, repeat Step 5 and Step 6 to select more files or folders to copy.

Figure 4-8. Copy Dialog Box
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8. Press the Scroll key to switch navigation control to the Dst (destination) pane. 
Alternatively, you can directly press a folder in the bottom pane to select it.

9. If the destination folder is off the screen, use the rotary knob or the Up/Down arrow 
keys to locate and select it.

10. Press the Copy key to copy the selected files or folders.

If a file by the same name already exists in the destination location, an error message is 
displayed, prompting you to press Enter to overwrite, or Esc to skip the conflicting file.

Delete Files 

Press the Delete key under the File menu to open the Delete dialog box and menu, where you 
can delete a single or multiple files or folders. Items to be deleted may be in the instrument’s 
internal memory or an external USB drive, if connected. However, you cannot select files and 
folders located in different drives simultaneously.

The files listed in the Delete dialog box depend on the chosen file type, which is selected using 
either the Filetype drop down list or the File Type submenu key. You can also change the way 
folders and files are sorted in the displayed list. Refer to “Delete Menu” on page 4-17. 

Use the touch screen, rotary knob, or the Up/Down arrow keys to highlight the file or folder 
you wish to delete. Then, press the Select or De-Select submenu key. The selected item is 
highlighted in blue. Pressing the key again deselects the current item.

To delete multiple files or folders, scroll to the next item and press the Select or De-Select key. 
Press the Delete key, then confirm or cancel the deletion in the confirmation box.

Figure 4-9. Delete Dialog Box
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4-3 File Menu Overview  
Open this menu by pressing the Shift key, then the File (7) key. 

Figure 4-10. File Menu
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4-4 File Menu 
Key Sequence: Shift > File (7) 

Save Measurement As: Pressing this key will save instrument setup 
parameters, trace data, and any measurement results to the file that is named 
on the submenu key. Upon Save completion, the file name numerical suffix 
increments by 1 and will be applied to the next Save. The file extension is 
determined by the current measurement mode, such as .spa for Spectrum 
Analyzer mode.

To save to a different file name than the default shown, or to change the save 
location, use the Save Measurement or the Save submenu key.

Save Measurement: Press this submenu key to display the “Save Menu” 
and Save dialog box. You can optionally enter a different file name using the 
keyboard in the Save dialog. You may also select the file type from the drop 
down list, as illustrated in Figure 4-13 on page 4-12. The list of available file 
types varies with the measurement mode.

Press Enter to save to the named file and return to the File menu. Pressing 
Esc exits the Save menu and dialog without saving.

The destination file for the saved data may be in the instrument’s internal 
memory or an external drive, typically a USB drive. To change the save 
location, refer to the “Save Location Menu” on page 4-13.

Save: Press this submenu key to display the “Save Menu” and Save dialog 
box. The available settings are the same as those of the Save Measurement 
key.

Save on Event (Not available in all measurement modes): Press this 
submenu key to display the “Save On... Menu” on page 4-14.

Recall Measurement: Press this submenu key to display the “Recall Menu” 
on page 4-15. Use this menu to recall measurement files from internal 
memory or an external drive, such as a USB memory stick.

Recall: Press this submenu key to display the “Recall Menu” on page 4-15. 
The available settings are the same as those of the Recall Measurement key. 
Use this menu to recall files (such as measurements, setups, limit lines, 
maps) from internal memory or an external drive.

Copy: Press this submenu key to display the “Copy Menu” on page 4-16. 
Use this menu to copy files and folders. The source and destination locations 
may be the instrument’s internal memory or an external USB drive.

Delete: Press this submenu key to display the “Delete Menu” on page 4-17 
and a selection box that lists the contents of internal memory and an external 
drive if connected. Use the rotary knob or the Up/Down arrow keys to scroll to 
the file that is to be deleted and press the Select or De-Select submenu key, 
then Delete. Press the Esc key to cancel the operation. Note that deleted files 
cannot be recovered.

Figure 4-11. File Menu
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Save Menu 

Key Sequence: Shift > File (7) > Save  

Restore Default Quick Name Buttons: Press this submenu key to undo 
any Quick Names previously entered and return all Quick Name buttons to 
factory defaults.

Change Quick Name: Press this key to change the Quick Names at the 
bottom of the touch screen keyboard (see Figure 4-13). Select the Quick 
Name to edit, then press Enter. Type the new Quick Name and press Enter 
again. The new Quick Name is displayed on the button below the keyboard.

Change Save Location: Press this submenu key to open the “Save Location 
Menu”, where you can set the location of the destination file for saved data.

Change Type
Setup/JPEG/... Press this submenu key to open the Select File Type list box 
and the “File Type Menu”.

Figure 4-12. Save Menu

Figure 4-13. Save Dialog Box
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File Type Menu 

Key Sequence: Shift > File (7) > Save Measurement > Change Type 

Key Sequence: Shift > File (7) > Save > Change Type 

Save Location Menu   

Key Sequence: Shift > File (7) > Save > Change Save Location 

JPEG Capture
Full Graph Only: Press this submenu key to toggle between file types, Full 
and Graphic Only. Choose Full to include all of the additional data on the 
measurement screen. Choose Graph Only to capture just the measurement 
trace in the sweep window.

Figure 4-14. File Type Menu

Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders are sorted in the Select Save Location list. See Figure 4-6 
on page 4-5.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the folder list 
between Ascending and Descending.

Create Folder: Press this submenu key to create a new folder inside the 
selected directory. Enter the new folder name in the Create Directory dialog 
and press Enter. To return to the Select Save Location dialog without creating 
a new folder, press Esc.

Set Location: Press this submenu key to set the currently selected folder as 
the destination where saved files will be stored, and to return to the “Save 
Menu” on page 4-12. Press Esc to exit without saving.

Refresh Directories: Press this key to update the folder list after connecting 
or disconnecting an external USB drive.

Figure 4-15. Save Location Menu
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Save On... Menu 

Key Sequence: Shift > File (7) > Save On Event 

In Spectrum Analyzer mode, this menu is used to automatically save 
measurements to the current save location after any of the following events:

...Crossing Limit
On Off: When this submenu key is set to On, measurement data is 
automatically saved when the trace crosses a limit line that has been 
specified with the Limit menu.

...Sweep Complete
On Off: When this key is set to On, measurement data is automatically 
saved after the current sweep is completed.

Save Then Stop
On Off: Set this key to On to stop the sweep after a measurement is 
saved. If this setting is Off and Sweep Complete is On, a measurement is 
saved after every sweep.

Clear All: Press this key to turn Off all three Save On Event keys:

Crossing Limit

Sweep Complete

Save Then Stop

Back: Press this key to return to the “File Menu” on page 4-11.

Figure 4-16. Save On Menu
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Recall Menu 

Key Sequence: Shift > File (7) > Recall 

Use these menu keys to change the way files are listed in the Recall dialog 
box. Navigate to the desired file, then press Enter to recall.

When recalling a saved setup, all current instrument settings are replaced by 
the stored setup information. When recalling a saved measurement and 
multiple traces are displayed, parameter settings shown on the instrument 
screen may reflect those of the recalled trace or the active trace, depending 
on the measurement mode or other factors.

Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders and files are sorted in the Recall dialog box. See Figure 4-7 
on page 4-7.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list 
between Ascending and Descending.

File Type: Press this submenu key to open the Select File Type list box. 
Press the desired file type on the list, then press Enter to apply the selection. 
JPEG image files cannot be recalled and are not listed.

Alternatively, you can select directly from the Filetype drop down list in the 
Recall dialog box.

Refresh Directories: Press this key to update the file list after connecting or 
disconnecting an external USB drive.

Figure 4-17. Recall Menu
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Copy Menu 

Key Sequence: Shift > File (7) > Copy 

Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders and files are sorted in the Copy dialog box. See Figure 4-8 
on page 4-8.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list 
between Ascending and Descending.

File Type: Press this submenu key to open the Select File Type list box. 
Press the desired file type on the list, then press Enter to apply the 
selection.

Alternatively, you can select directly from the Filetype drop down list in the 
Copy dialog box.

Refresh Directories: Press this key to update the file list after connecting 
or disconnecting an external USB drive.

Scroll
Src Dst: Press this submenu key to shift navigation control between the 
source and destination panes in the Copy dialog box.

Select or De-Select: Press this key to select or deselect the current file or 
folder. Selected items are highlighted in blue.

Copy: Copies the selected files and folders, highlighted in blue in the top 
pane of the Copy dialog box, to the selected location in the bottom pane. If a 
file by the same name already exists in the destination location, an Error 
message is displayed, prompting you to press Enter to overwrite, or Esc to 
skip the conflicting file.

Figure 4-18. Copy Menu

Sort By

Name    Type    Date

Sort Order

Ascend     Descend

Scroll

Src                Dst

File Type

ALL

Refresh

Directories

Select
or

De-Select

Copy

Copy



File Management 4-4 File Menu

MS2720T UG PN: 10580-00340  Rev. R 4-17

Delete Menu

Key Sequence: Shift > File (7) > Delete 

 

Sort By
Name Type Date: Press this submenu key to choose the item by which 
folders and files are sorted in the Delete dialog box. See Figure 4-9 
on page 4-9.

Sort Order
Ascend Descend: Press this key to toggle the sort order of the file list 
between Ascending and Descending.

File Type: Press this submenu key to open the Select File Type list box. 
Press the desired file type on the list, then press Enter to apply the 
selection.

Alternatively, you can select directly from the Filetype drop down list in the 
Delete dialog box.

Select or De-Select: Press this key to select or deselect the current file or 
folder. Selected items are highlighted in blue.

Delete: Deletes the selected files or folders, which are highlighted in blue. 
In the confirmation box, press Yes to delete, No to cancel. You can also 
press Esc to cancel the deletion.

Refresh Directories: Press this key to update the file list after connecting 
or disconnecting an external USB drive.

Figure 4-19. Delete Menu
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Chapter 5 — System Operation

5-1 Introduction
This chapter reviews the Spectrum Master system operations and related menus. The other 
menus (Sweep, Measure, Trace, and Limit) are described in the Measurement Guides listed 
in Appendix A.
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5-2 System Menu Overview 
To access the System menu functions, press the Shift key, then the System (8) key. 

Figure 5-1. System Menu
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5-3 System Menu  
Key Sequence: Shift > System (8) 

Status: Pressing this submenu key displays the current system status, 
including the operating system and firmware versions, temperatures and 
other details such as current battery information. Press Esc or Enter to return 
to normal operation.

Self Test: This key initiates a series of diagnostic tests related to the 
performance of the motherboard hardware. A display will list the individual 
tests with a pass or fail indication. Press Esc or Enter to return to normal 
operation.

If the self test fails when the battery is fully charged and the instrument is 
within the specified operating temperature, contact your Anritsu Service 
Center and report the test results.

Application Self Test: Press this submenu key to run a series of diagnostic 
tests related to the performance of the instrument hardware and that are 
specific to the current instrument mode (refer to “Mode Selector” 
on page 2-18). Press the Esc key to abort, or press Enter to continue. The 
display lists a summary of those tests that have passed. If any test fails, all of 
the performed tests are then listed with Pass/Fail notification. In this case, 
contact your Anritsu Service Center and report the test results.

Some of the hardware that is tested may also be used in multiple operating 
modes. One or more additional submenu keys may be displayed to allow 
other application self tests, depending on the installed options. For example, 
in an instrument model with the Tracking Generator option, when the test 
results are displayed, a TG Self Test submenu key is provided for an 
additional test. A Microwave Module Self Test is available with the 32 GHz 
and the 43 GHz Frequency options.

GPS: Opens the “GPS Menu” on page 6-4.

Calibrate Touch Screen: If the instrument does not respond as expected 
when you press the touch screen, press this key to display the touch screen 
calibration message box. Refer to “Touch Screen Calibration” on page 2-14.

The front panel shortcut equivalent of this submenu key is Shift, 0 (zero). 
Refer to “Calibrate Touch Screen Shortcut” on page 2-14.

Application Options: This submenu changes with the measurement mode. 
Refer to the appropriate Measurement Guide, as listed in Appendix A.

System Options: Press this submenu key to open the “System Options 
Menu” on page 5-4.

Figure 5-2. System Menu
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System Options Menu  

Key Sequence: Shift > System (8) > System Options 

Date & Time: Press this submenu key to display a dialog box for setting the 
current date and time. Use the submenu keys or the Left/Right arrow keys to 
select the field to be modified. Use the keypad, the Up/Down arrow keys, or 
the rotary knob to select the date and time. Press Enter to accept the 
changes, or press the Esc key to return to normal operation without making 
changes.

Ethernet Config: Press this submenu key to display the Ethernet submenu 
and to open the Ethernet Editor dialog box, where you can set the instrument 
IP address. For details, refer to “Ethernet Menu” on page D-2.

Language: Press this submenu key to open a list box and select a built-in 
language for the instrument display. Press Enter to apply the change, or 
press Esc to cancel.

The languages that are currently available are: English, French, German, 
Spanish, Japanese, Chinese, Korean, Italian, Russian, and Portuguese. You 
can edit non-English language captions using Master Software Tools (MST). If 
a mode does not have language translations available, then English is the 
default language.

Caution: A firmware update or any instrument reset will overwrite 
modifications you may have made in any of the language files.

Display: The Display submenu key opens the “Display Settings Menu”, 
allowing brightness control and the selection of different display attributes.

Name: Press this submenu key to open the Unit Name dialog, where you can 
enter a name for the instrument, using the touch screen keyboard. Press 
Enter to save the name.

The assigned instrument name appears in measurement files, setup files, 
limit line files, and MST reports. It is displayed on the browser page banner 
when the instrument is connected to a remote PC or mobile device.

Volume: Press this submenu key to view or adjust the speaker volume. The 
current volume setting is displayed in the Volume input box. Use the numeric 
keypad, the Up/Down arrow keys, or the rotary knob to change the value, and 
press Enter to apply the change.

Reset: Press this submenu key to open the “Reset Menu” on page 5-9.

More: Press this submenu key to open the “System Options 2/2 Menu” 
on page 5-5.

Figure 5-3. System Options Menu (1 of 2)
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System Options 2/2 Menu    

Key Sequence: Shift > System (8) > System Options > More     

Share CF & Pwr Offset
All Modes Not Shared: Press this submenu key to toggle the setting 
between All Modes and Not Shared. Select All Modes to have the current 
center frequency setting and power offset setting carried over when changing 
measurement modes. This function is not applicable to measurements that do 
not have a center frequency or power offset setting or to measurements in 
which the current center frequency or power offset setting is outside the range 
of the new measurement.

Set Remote Access Password: Press this submenu key to open the 
Password entry dialog (see Figure 5-5 on page 5-6). Use the touch screen 
keyboard to enter the new password. Passwords may contain digits, 
uppercase and lowercase letters, and the symbols - _ + . (hyphen, 
underscore, plus, period). Press Enter to save or Esc to cancel.

Setting the remote password and rebooting the instrument will lock it from 
Telnet and FTP connections. This means that connecting to the instrument via 
Master Software Tools (v2.21.1 or later), Wireless Remote Tools (WRT), or 
the Web Remote Control browser interface will require the set password. To 
unlock the instrument, remove the password by setting it to blank. The 
password is also removed following a Master Reset, Factory Defaults reset, or 
a firmware update.

Power–On: Press this submenu key to open the “Power-On Menu” 
on page 5-6.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-4. System Options Menu (2 of 2) 
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Power-On Menu

Key Sequence: Shift > System (8) > System Options > More > Power–On 

Figure 5-5. Remote Access Password Dialog
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on page 3-11.

Back: Press this submenu key to return to the “System Options 2/2 Menu” 
on page 5-5.
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5-4 Display Settings Menu
Key Sequence: Shift > System (8) > System Options > Display  

Brightness: Opens the “Brightness Settings Menu” on page 5-8.

Display Blank: Opens the message box illustrated in Figure 5-8. Press 
Enter to turn off the display, or press Esc to abort. To turn the display back on, 
press any key (except the Power button) three times in rapid succession. A 
power cycle also turns the display back on.

Default Colors: Sets the display colors to the factory defaults. Used for 
normal viewing.

Black on White: Sets the display colors to black on a white background. 
Used for printing and viewing in broad daylight conditions. See Figure 2-10 
on page 2-13 for illustrations of the display color schemes selectable in this 
submenu.

Night Vision: Sets the display to a red-tinted color on a black background. 
The front panel keypad is backlighted in red. This setting is optimized for 
nighttime viewing.

High Contrast: Increases the black and white contrast of the default display. 
This setting is used in challenging viewing conditions.

Color on White: Sets the display background to white, the grid to gray, and 
leaves sweep data in color. This setting is used for printing and viewing in 
broad daylight conditions.

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-7. Display Settings Menu

Figure 5-8. Display Blank Message Box
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Brightness Settings Menu 

Key Sequence: Shift > System (8) > System Options > Display > Brightness  

The brightness of the display can be adjusted to optimize viewing under a 
wide variety of lighting conditions.

Brightness: Press this submenu key to open the Brightness Editor window, 
where you can adjust the display brightness level from 0 to 100, with 100 
being the brightest. See Figure 5-10. Use the rotary knob to adjust the value 
in increments of 5, or press the Up/Down arrow keys to change the value in 
increments of 25. Press the Left or the Right arrow key to jump to 0 or 100, 
respectively. Press Enter to accept the change. All display elements on the 
instrument screen are affected by the Brightness setting.

Auto Dim On/Off: Press this submenu key to toggle the display 
auto-dimming feature on and off. Enabling auto-dim can extend battery life.

Auto Dim Delay: Press this key to adjust the amount of idle time, from 1 to 
15 minutes, before the instrument display goes dim. Use the arrow keys or the 
rotary knob to adjust the value in increments of 1. You can also use the 
numeric keypad, then press Enter. Out-of-range values are ignored.

Auto Dim Brightness: Press this submenu key to select the brightness 
percentage level of the display when it is dimmed. Use the arrow keys or the 
rotary knob to adjust the value in increments of 5%, from 0% to 25%. You can 
also use the numeric keypad, then press % or the Enter key. Out-of-range 
values are ignored.

Back: Press this submenu key to return to the “Display Settings Menu” 
on page 5-7.

Figure 5-9. Brightness Settings Menu

Figure 5-10. Brightness Editor Input Box
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Reset Menu 

Key Sequence: Shift > System (8) > System Options > Reset    

Factory Defaults: Press this key to restore the instrument to the default 
settings for all measurement modes and system settings, including 
connectivity, language, and the display and audio settings. The instrument will 
power cycle when the operation is complete. Press the Enter key to initiate 
the reset, or press Esc to abort.

Master Reset: Press this submenu key to restore the instrument to factory 
defaults as described above and to delete all user files from the instrument 
internal memory. The instrument will power cycle when the operation is 
complete. Press Enter to initiate the reset, or press Esc to abort.

Update Firmware: Press this submenu key to update the instrument 
operating system using an external USB drive. Press Load Firmware to start 
the update procedure, or press the Menu key to cancel and display the Menu 
key screen of application icons.

Frequency Blanking On/Off (Option 7 Only): The Frequency Blanking 
submenu is displayed only when Option 7, Secure Data Operation, is installed 
on the Spectrum Master. When Frequency Blanking is turned On, all 
frequency values that are displayed on the screen and menu buttons are 
replaced with ##.#####. This security measure allows the use of the 
instrument without sensitive frequency information being displayed on the 
screen.

Note that saved measurements retain the frequency information, which may 
then be viewed on a PC, or recalled after frequency blanking is turned off.

Setting Frequency Blanking to Off will preset the instrument settings and 
frequencies to the factory default settings (the current frequency settings will 
not be saved or displayed on the instrument).

Back: Press this submenu key to return to the “System Options Menu” 
on page 5-4.

Figure 5-11. Reset Menu
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5-5 Preset Menu  
Key Sequence: Shift > Preset (1) 

5-6 Self Test 
At power on, the instrument runs through a series of quick checks to ensure that the system 
is functioning properly. The System self test runs a series of tests that are related to the 
Spectrum Master hardware. The Application self test runs a series of tests related to the 
instrument hardware that is used in the current operating mode.

If the instrument is within the specified operating range with a charged battery and the self 
test fails, contact your Anritsu Service Center at:  http://www.anritsu.com/contact-us.

To initiate a self test when the system is already powered up:

1. Press the Shift key, followed by the System (8) key.

2. Press the Self Test submenu key. The Self Test results are displayed.

3. Press Esc to close the Self Test results dialog.

Preset: This key resets all parameter settings for the current measurement 
mode to their factory default values, and switches the display to the default 
view for that mode. Measurement settings specific to other modes, or 
applications, are not affected.

Save Setup: Opens the Save dialog box (see Figure 4-1 on page 4-2) to 
name and save the current operating settings, allowing them to be recalled 
later to return the instrument to the state it was in at the time the setup was 
saved.

The saved setup can be named using the touch screen keyboard. Use the 
Caps key to select an uppercase letter. Use the Left/Right directional arrows 
to move the cursor position. Press Enter to save the setup.

Note: Set the File type as Setup. Refer to “Save Menu” on page 4-12 for 
details.

Recall Setup: This key allows the selection and recall of a previously stored 
instrument setup using the “Recall Menu” on page 4-15. Use the rotary knob, 
the Up/Down arrow keys, or the touch screen to highlight the saved setup, 
and press Enter. All current instrument settings are replaced by the stored 
setup information.

Figure 5-12. Preset Menu

Recall

Setup

Preset

Save

Setup

Preset

http://www.anritsu.com/contact-us


System Operation 5-7 Updating the Spectrum Master Firmware

MS2720T UG PN: 10580-00340  Rev. R 5-11

5-7 Updating the Spectrum Master Firmware 
The Spectrum Master is updated using a USB memory device. Updated product information 
can be found on the Anritsu website:

http://www.anritsu.com/en-US/test-measurement/products/ms2720t 

1. Click the Downloads link, then click the Drivers/Firmware/Software tab.    

2. After the download is complete, run the executable Windows file and follow the 
on-screen instructions. Press “Help (?)” for additional information.

3. After the firmware update is saved on a USB memory device, eject the memory device 
from the computer.

4. Turn the Spectrum Master off and insert the memory stick into the instrument.

5. Connect the AC adapter and turn on the Spectrum Master.

6.  The instrument should prompt you to update the firmware. Press Yes, then select the 
desired “Save” mode from the presented choices, and then follow the instrument 
prompts. Press No if you do not wish to update the firmware.

7. If the automatic update did not start, complete the following steps:

a. On the instrument, press the Shift key, then the System (8) key.

b. Press the following key sequence: System Options > Reset > Update Firmware. 
The Load Firmware menu opens.

c. Press the Load Firmware main menu key (located at the bottom left corner of the 
instrument screen).

d. Press the Update Application Firmware submenu key.

e. From the choices presented, select the desired “Save” mode.

f. Press the Enter key to begin the firmware update.

g. Press the Enter key one more time to confirm that you want to upgrade the 
instrument firmware.

8. After the update is complete, the instrument will restart.

Note The “Firmware Revision History” link provides a summary of the firmware changes.

Note
Do not turn off the instrument during the firmware update to avoid potential 
permanent damage.

Note
Do not turn off the instrument during the firmware update to avoid potential 
permanent damage.

http://www.anritsu.com/en-US/test-measurement/products/ms2720t
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Chapter 6 — GPS (Option 31)

6-1 Introduction
The Spectrum Master MS2720T is available with a built-in GPS receiver feature (Option 31) 
that can provide latitude, longitude, altitude, and UTC timing information. This option also 
enhances frequency reference oscillator accuracy in the spectrum analyzer mode. When GPS 
is actively locked to satellites, this information is saved with all saved measurements and can 
be displayed with Master Software Tools. No accuracy specifications apply if no GPS 
satellites are acquired.

6-2 Activating the GPS Feature
Attach the GPS antenna to the GPS Antenna connector on the top of the instrument.

1. Press the Shift key, then the System (8) key on the numeric keypad to display the 
System menu.

2. Press the GPS submenu key.

3. Activate GPS by pressing the GPS On/Off submenu key so that On is underlined. When 
GPS is first turned On, the GPS icon is displayed in red to indicate that fewer than four 
satellites are currently being tracked.

Note

The Spectrum Master Technical Data Sheet provides a list of the options and 
measurements that require GPS (Option 31). In addition to having Option 31 
installed, a GPS antenna is required. Refer to the instrument Technical Data Sheet 
for compatible GPS antennas.

Figure 6-1. GPS Icon, Red

GPS
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4. When the GPS receiver is tracking at least four satellites, the GPS icon changes to 
green. Latitude and longitude information is displayed in the title bar at the top of the 
display. Acquiring satellites may take as long as three minutes. 

5. Press the GPS Info submenu key to display the following information: 

• Tracked satellites

• Latitude and longitude

• Altitude

• UTC timing information

• Fix available

• Almanac complete

• Antenna and receiver status

• GPS antenna voltage and current

Refer to “GPS Menu” on page 6-4 for details on the above GPS Info items.

After GPS location fix is attained, the internal reference oscillator begins to correct its 
frequency to match the GPS standard. After the internal frequency is adjusted to match the 
GPS standard, the status is indicated by “GPS High Accuracy” showing in the Status menu, 
which is displayed on the left side of the measurement display. When the GPS feature is not 
enabled, the reference source displays either “Internal Standard Accuracy” or a user-selected 
external reference frequency in the Status menu.

Within three minutes of satellite acquisition, the reference oscillator will have an accuracy of 
better than 25 ppb (parts per billion). The correction factor applied to the internal OCXO 
allows the instrument to maintain GPS frequency accuracy for three days at better than 
50 ppb, even when the instrument is obstructed from receiving signals from the GPS 
satellites.

In order to acquire data from the GPS satellites, you must have line-of-sight to the satellites, 
or the antenna must be placed outside with no obstructions.

If no GPS is connected for at least three days, the Frequency Reference annotation reads Int 
Std Accy.

When GPS is connected, with a fix, and the tuning process has completed (which may take a 
few minutes), the Frequency Reference annotation shows GPS Hi Accy. If GPS is 
subsequently lost (for example, GPS is turned off, disconnected, or there is no signal due to 
physical obstruction), the instrument goes back to Int Hi Accy after a few moments. If GPS 
remains disconnected for three consecutive days, whether the instrument is on or off, the 
instrument reverts to Int Std Accy.

Figure 6-2. GPS Icon, Green

GPS
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6-3 Resetting GPS
To reset the GPS, press the Reset submenu key. The green GPS icon shows a red cross mark 
when satellite tracking is lost after tracking four or more satellites. The GPS latitude and 
longitude are saved in the instrument memory until the Spectrum Master is turned off or 
until GPS is turned off by using the GPS On/Off key. 

6-4 Saving and Recalling Traces with GPS Information

Saving Traces with GPS Information

The GPS coordinates of a location can be saved along with a measurement trace. Refer to 
“Save Menu” on page 4-12 for more information. The current GPS coordinates will be saved 
with the measurement traces whenever GPS is on and actively tracking satellites.

Recalling GPS Information

If the GPS coordinates were saved with a measurement, the coordinates will be recalled when 
the measurement is recalled. Refer to “Recall Menu” on page 4-15 for more information on 
recalling a saved trace.

Figure 6-3. GPS Icon, Tracking Lost

GPS
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6-5 GPS Menu 
Key Sequence: Shift, System (8) > GPS 

GPS: Press this submenu key to turn GPS on or off.

GPS Info: Press this submenu key to display the current GPS information.

Tracked Satellites: Shows the number of tracked satellites (three are 
required to retrieve latitude and longitude, four are required to resolve 
altitude). Generally, the larger the number of satellites tracked, the 
more accurate the GPS information.

Latitude and Longitude: Shows location in degrees, minutes, and 
seconds.

Altitude: Shows altitude information in meters.

UTC: Universal Coordinated Time.

Fix Available: The cold start search sets are established to ensure 
that at least three satellites are acquired within the first couple of 
minutes. When three satellites are found, the receiver will compute an 
initial fix (typically in less than two minutes). Fix Available: No means 
that the initial position has not been established.

Almanac Complete: The system almanac contains information about 
the satellites in the constellation, ionospheric data, and special system 
messages. In a cold start, the GPS receiver has no navigation data, so 
the receiver does not have a current almanac. A complete system 
almanac is not required to achieve a first position fix. However, UTC 
time is not correct until the almanac is complete, and the availability of 
the almanac can significantly reduce the time to first fix.

Antenna Status:
OK: Active antenna is connected and is working properly.

Short/Open: If an active antenna is in use, a short or open exists 
between the antenna and the connection. If this message is displayed, 
replace the antenna. If the message persists, try another Anritsu GPS 
antenna. If needed, contact your nearest Anritsu Service Center. If a 
passive antenna is in use, the message should display: Antenna 
OPEN Detected or Passive Antenna Used.

Receiver Status: Current status of the receiver.

GPS Antenna Voltage and Current: Shows voltage and current.

GPS Voltage: Press this submenu key to set the source voltage at 3.3 V or 
5 V, depending on the GPS receiver being used. The default setting is 3.3 V 
to prevent accidental damage to lower-voltage GPS antennas.

Reset: The Reset key sets the number of tracked satellites to 0 and erases 
any almanac data and saved coordinates. The process of searching for and 
reacquiring satellites will begin again.

Back: Press this submenu key to return to the “System Menu” on page 5-3.

Figure 6-4. GPS Menu

GPS

Back

GPS

On               Off

GPS Voltage

3.3 V             5 V

GPS Info

Reset



MS2720T UG PN: 10580-00340  Rev. R 7-1

Chapter 7 — Anritsu Tool Box

7-1 Introduction
The Anritsu Tool Box is a suite of applications that provide an interface between Anritsu 
handheld RF instruments and a PC. The instrument connects to the computer via a USB, 
Ethernet, or serial port. Depending on the application selected, available functions range 
from the capture, transfer, and reporting of measurement data for trace analysis, to map 
preparation, creation and delivery of work instructions, and remote instrument monitoring 
and control. This chapter gives an overview of the software installation and the main features 
of each application in the Anritsu Tool Box.

The Tool Box may be downloaded and installed from the Anritsu website at:

 www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx 

7-2 Software Installation
Use Windows Explorer to find and launch the executable setup file, then follow the on-screen 
instructions. You will be asked to select which applications you wish to install. Not all 
instrument models are supported by every software tool. Visit the web page referenced in the 
Introduction section above and follow the links for more information on a specific tool. 

Figure 7-1. Anritsu Tool Box Setup Wizard 

www.anritsu.com/en-US/Services-Support/Handheld-Tools-Tool-Box.aspx
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7-3 Anritsu Software Tool Box
The Anritsu Tool Box serves as a central location from which you can open a previously saved 
measurement, visit the Anritsu website, or launch an application. To open the Tool Box, 
either double-click the desktop shortcut or select the Tool Box from the Windows Start menu, 
under All Programs and the Anritsu folder. On the Tool Box screen, hover the mouse pointer 
over any of the application icons to view a short description of the application. See Figure 7-2. 

7-4 Software Tools
The Anritsu Tool Box provides links to the software tools installed on your PC. Alternatively, 
you can launch an application using its desktop shortcut or through the Windows Start menu.

The following sections list the top features and functions of the tools contained in the Anritsu 
Tool Box that are compatible with the Spectrum Master MS2720T. For a detailed description 
of these features and how to perform specific tasks, refer to each application’s Help system. 
The program Help also lists the instrument models, measurement modes, trace types, and file 
types that are compatible with that application.

Figure 7-2. Anritsu Tool Box Screen (may change with software version)
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Master Software Tools (MST)

Master Software Tools is designed for users of Anritsu handheld spectrum analyzers, 
interference analysis tools, transmission testers, and backhaul testers. Supported functions 
include the following:

• Transfer of captured measurement data to and from a PC for storage and analysis

• RF Spectrum Analyzer traces

• RF Interference analysis

• Spectrum monitoring

• Transmitter signal quality tests

• T1, T3, and E1 backhaul tests

• Trace overlay features for comparing multiple Spectrum Analyzer measurements

• Limit lines and markers

• Script Master for the creation of automated test procedures

• Export measurement data as text, graphic, or Comma Separated Value format (CSV) 
files

• Reports created in HTML format for use in other applications

easyTest Tools

easyTest Tools is used to create work instruction files that consist of a command sequence 
and intructions to help less experienced personnel with operating the instrument in the field.

• A drag-and-drop tool facilitates the creation of a test sequence from a library of 
commands.

• Instructions can be a mix of textual prompts and graphic images.

• Sample procedure files (.ett) are included with easyTest Tools.

• Command sequences are delivered electronically and loaded on the instrument, where 
they are recalled with a press of a button.

• Recall Setup places the instrument in the proper mode and fully configured for the 
measurement, including the measurement type, frequency and amplitude settings, and 
markers and limit lines.

• The current measurement setup or the screen display can be saved manually or 
automatically.

easyMap Tools

easyMap Tools is the new name for Anritsu Map Master. The application allows users to find 
and prepare geo-referenced maps and to build floor plans suitable for Anritsu Handheld 
Spectrum Analyzers with Interference Analysis or Coverage Mapping capabilities. Software 
functions include:

• Creation of geo-referenced maps with pan and zoom capability

• Conversion of maps and floor plans to a form suitable for use on Anritsu Handheld 
Spectrum Analyzers and Interference Analyzers

• Introduction of GPS information into previously non-geo-referenced maps
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Wireless Remote Tools

Wireless Remote Tools enables the user to remotely monitor and control the instrument over 
a wireless LAN connection.

• The wireless connection is typically established using a USB-powered Wi-Fi router 
attached to the instrument and a matching Wi-Fi link on the PC end.

• Remote monitoring and control of the instrument enhance operator safety and 
efficiency when conditions make it unsafe or impractical to be close to the instrument.
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Chapter 8 — Web Remote Control

8-1 Introduction
Web Remote Control capabilities are embedded in the Spectrum Master, providing full 
instrument control through an HTML-5 compatible browser. The ability to remotely monitor 
and control the instrument from the ground or desk enhances operator safety and efficiency 
when conditions make it unsafe or impractical to be close to the instrument. Login passwords 
can be used to allow access to authorized users only.

A remote connection terminates when the user logs out or closes the browser, or when the 
session time requested at login expires. To prevent multi-user conflicts, only one connection is 
permitted at a time. A second user who tries to log in will see a message indicating the 
instrument is currently reserved by another client, with the time remaining in their session.

While only one user can have control of the instrument, multiple users can view the same 
instrument using a desktop sharing application.

8-2 Setup
You can connect one or more instruments to any computer with HTML-5 compatible browser. 
Anritsu strongly recommends using Google Chrome, as other browsers do not fully support 
HTML-5. The control device may be a laptop, a desktop computer, or a mobile device, 
including a wide range of tablets and smart phones running Android or iOS operating 
systems. Note that you cannot download files to an iOS device, for lack of a user-accessible file 
system in this environment.

Physical connection is established from the instrument’s Ethernet port directly to the 
computer, or to a LAN or a portable Wi-Fi router such as the ZyXEL MWR102 Portable 
Router.

LAN Connection

1. Connect the Ethernet port of the Spectrum Master to your LAN.

2. Press Shift followed by System (8).

3. Press the Status submenu key to display the Status window and take note of the 
instrument IP address.

Press Esc to close the Status window.

4. If no IP address has been assigned, refer to Appendix D, “LAN and DHCP” for 
information on setting an IP address for the instrument. If connecting to another 
network, we recommend that you request a static IP address from your network 
administrator to avoid duplicate addresses.

Alternatively, you can set the instrument for dynamic IP addressing using DHCP. 
Refer to “Ethernet Menu” on page D-2. In a long distance network, however, it may be 
difficult or impossible to determine what the current dynamic address is, after the 
instrument is in the field.
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5. Set instrument parameters as appropriate, such as measurement mode, frequency 
range, amplitude. You may skip this step and set up the instrument remotely at a later 
time, after Ethernet connection has been established.

6. Launch the Google Chrome browser on your PC, laptop, or mobile device. Due to 
compatibility issues with HTML-5, do not connect using another browser than Chrome.

Enter the instrument IP address in the browser address bar to open the Web Remote Control 
Login page illustrated in Figure 8-1 on page 8-3.

Connection to a Wi-Fi Portable Router

Instead of connecting the instrument directly to a LAN, you can connect it to a Wi-Fi router. 
This section documents connection to the ZyXEL MWR102 Portable Router as an example.

1. Take note of the router’s SSID and pre-programmed password, which are found on a 
sticker affixed to the router.

2. Using the Ethernet cable included with the router, connect one end to the black LAN 
port and the other end to the test instrument’s Ethernet port.

3. Insert the Mini-B (small) end of the provided USB cable into the router and the Type-A 
(larger) end of the cable into one of the USB ports of your test instrument.

4. Optionally, secure the router to the instrument body using a strip of Velcro or other 
hook-and-loop fastener. You may also place the router in the instrument carrying case, 
if it fits.

5. Use your computer’s Wi-Fi Network Connection utility to find the router. With the 
ZyXEL MWR102 Portable Router, the SSID name will be ZyXEL followed by an 
alphanumeric string unique to your particular router.

6. Connect to this SSID. When prompted, enter the router password noted in Step 1.

7. Set the IP address manually on the instrument. Refer to “Ethernet Menu” on page D-2.

8. Launch the Google Chrome browser on your PC, laptop, or mobile device. Due to 
compatibility issues with HTML-5, do not connect using another browser than Chrome.

9. Enter the instrument IP address in the browser address bar to open the Web Remote 
Control Login page illustrated in Figure 8-1 on page 8-3.
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8-3 Web Remote Control Interface
The Web Remote Control Login page opens following browser connection to the instrument. 
See Figure 8-1. The page may show or hide certain elements depending on device 
management options set by the Administrator, as described in “Device Options” on page 8-11. 

User Login

To start a remote session with a test instrument:

1. Enter the instrument IP address in the Google Chrome address bar. The instrument 
must be connected via Ethernet as described in “Setup” on page 8-1.

2. Use the pull-down menus on the Login page to set the time, in hours and minutes, 
before the remote session times out. The default session time is 1 hour, with a 10-hour 
maximum. 

Only one user at a time can connect to the instrument. To avoid locking out other users 
unnecessarily, do not reserve a longer session than you need.

3. To enable functions available only to the network administrator, select the Login as 
Administrator checkbox. 

4. Enter the instrument password, then click Login.

The default administrator password is “Admin” with a capital A. The default password 
for other users is None; that is, leave the field blank. 

If another user already has control of the instrument when you try to log in, a message will 
display indicating the instrument is currently reserved by another client, whose IP address is 
listed with the time remaining in their session.

Following login, the Web Remote Control Home page is displayed.

Figure 8-1. Login Page



8-3 Web Remote Control Interface Web Remote Control

8-4 PN: 10580-00340  Rev. R MS2720T UG

Home Page

The Web Remote Control Home page lists the same information as what is displayed on the 
instrument screen when you press Shift, System (8) at the front panel, followed by the Status 
menu key.

At the top of the page, a green banner shows the instrument model number and IP address. If 
the instrument has been assigned a name, this name is displayed in the center of the banner.

The menu bar below the banner consists of tabs for commands and links: Home, Remote 
Control, Capture Screen, Capture Trace, File List, Device Management, and Logout. 

Figure 8-2. Web Remote Control Home Page
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Remote Control

The Remote Control page displays a bitmap image of the instrument screen. The buttons on 
the right of the display reflect the layout of the buttons on the instrument and are used to 
access the same monitoring and control functions. See Figure 8-3.  

Session Time Remaining 

This is the amount of time remaining before your remote session automatically terminates. 
The session time is reserved at login. It can be changed on the Device Management page.

Normal Mode

Normal Mode is the default mode, where the bitmap image of the instrument screen is 
continually refreshed in the browser window. Click the single arrow button near the bottom 
right of the page to return to Normal Mode from either Fast or Pause Mode. Clicking any tab 
on the menu bar also returns to Normal Mode.

Figure 8-3. Remote Control Page

Notes

• When clicking a key or measurement icon on the Remote Control page, a 
small green dot appears at the point of the cursor to indicate that the key, 
button, or icon was pressed.

• A single Web-enabled device can monitor and control multiple instruments. 
However, multiple Web-enabled devices with different IP addresses cannot 
connect to the same instrument simultaneously.
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Fast Mode

Click the double arrow button to enter Fast Mode, where the update rate can be significantly 
faster than Normal mode, especially over low bit-rate connections. Only the measurement 
data (yellow trace) is continually updated. The main menu keys and submenu keys may look 
different than in Normal Mode, but their functions are the same. Error messages are not 
shown in Fast Mode.

Fast Mode is not available with some Spectrum Analyzer measurement types, in which case 
the Fast Mode button is disabled. The button is not displayed when the measurement mode is 
something other than Spectrum Analyzer.

While in Fast mode, if a measurement type is selected that Fast mode does not support, the 
instrument will return to Normal mode.

Pause Mode

Clicking the Pause button turns the Communication Activity dot in the lower right-hand 
corner to yellow. If the interface was in Normal Mode, this stops the instrument display from 
refreshing in the browser window. If the interface was in Fast Mode, the trace measurement 
stops updating. Click the single arrow or the double arrow button to resume remote 
communications with the instrument in Normal or Fast Mode, respectively. The 
Communication Activity dot then returns to green.

Communication Activity

The moving dot labeled Communication Activity, when green, indicates that ongoing 
communication is occurring between the instrument and PC. When you click Home, Capture 
Screen, Capture Trace, File List, Device Management, or Logout on the menu bar, the 
Communication Activity dot briefly turns yellow before the selected page opens in the 
browser.

Configure Timeout

If the Ethernet connection is poor and you expect frequent lags in response time, you can 
increase the timeout up to 20 seconds, before the instrument sends an “Instrument Busy” 
message. The default timeout is 3 seconds.
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Capture Screen

Captures a JPEG image of the current instrument display and saves it directly to internal 
memory. A file name is automatically created using the current date and time stamp. The 
captured display is loaded to the browser page, under the menu bar. See Figure 8-4. In 
Windows, you can right-click on the screen image and select Copy. With iOS, press and hold 
on the picture. This makes it easy to create documentation using screen captures.  

Capture Trace

Opens an input dialog to enter a name for the trace to be saved. See Figure 8-5. After clicking 
Save, a confirmation dialog opens to indicate the trace was successfully saved to the 
instrument.  

Depending on the browser and operating system used, different prompts may appear. Some 
operating systems like iOS may not support file saving from a browser.

Figure 8-4. Capture Screen Page

Figure 8-5. Capture Trace Page
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File List

Displays the list of folders (type “dir”) and files contained in the instrument's internal 
memory. See Figure 8-6. To view the contents of a folder, click on the folder name. 

To download a file, click the file name. Alternatively, you can select the checkbox on the left of 
the file name, then click Download. You may also select the checkboxes of multiple files and/or 
folders and download them together, as a zipped folder. In this case, a pop-up dialog box 
shows the estimated download time. Press OK to continue. 

Depending on the browser and operating system, the download function may allow you to 
open the file or save it, or both. In Google Chrome, for example, the downloaded file or files 
are automatically saved to the designated folder on your computer, such as the Downloads 
folder. In the banner at the bottom of the browser window, click a downloaded item to open it.

If the selected item is a single file, the file will open in the default application for the file type. 
For example, a JPEG file will open in the computer's default image viewer, while a 
measurement file will open in Master Software Tools (MST), provided the application is 
installed.

Device Management (not as Administrator) 

Click the Device Management tab on the menu bar to set or clear the instrument password, to 
assign a device name to the instrument, or to change the session time. See Figure 8-7.

If you logged in as Administrator, the Device Management page has additional sections for 
viewing the remote access log and for setting device options. Refer to “Device Management 
(Administrator)” on page 8-10.

Password 

If no password is set, which is the factory default, remote access to the instrument is 
unrestricted and any user who knows the instrument IP address can connect to it, provided 
the device isn’t currently reserved by another client. When a password is set, it is required 
upon login. To clear the current password, click the Reset button. This password is different 
from the administrator password described under “Device Management (Administrator)”.

Figure 8-6. File List Page

Note Some operating systems, like iOS, do not support file downloads.
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Instrument Name 

The instrument name, if defined, is displayed in the green banner at the top of the page. It is 
useful in identifying the instrument when you have more than one instrument connected. The 
name can be assigned remotely from this Device Management page, or it can be set from the 
instrument's System Options menu. Note that this instrument name is not a "hostname" as 
used in an Ethernet router.

Session Time 

Use the pull-down menus to select the time, in hours and minutes, before the remote session 
times out. Click Update to reset the session timer at the specified duration. At the end of the 
selected time period, a message notifying the user that the session has expired will display. 

Figure 8-7. Device Management Page

Figure 8-8. Session Expired
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Device Management (Administrator) 

Logging in as Administrator gives you access to additional functions associated with the 
instrument’s remote connection log and the display of information on the Login page. 

Figure 8-9. Device Management Page (Administrator)
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Administrator Password 

A password is always required to log in as Administrator. The password is case-sensitive, 
with “Admin” as the factory default. To change the password, type your new entry twice and 
click Save. See Figure 8-9 on page 8-10.

To restore the default password, click the Reset button. The administrator password is also 
reset to default each time you update the instrument firmware.

Access Log 

The Access Log is viewable only when you are logged in as Administrator. It contains the date 
and time, success or failure status, and user information for up to 50 most recent login 
attempts. To save a copy of the log to the default download location on your control device, 
click Download Log. The saved file is a comma-delimited CSV file that can be opened with an 
application like Microsoft Excel. Click the Clear Log button to empty the Access Log. 

Device Options 

When logged in as Administrator, you have the option to turn on or off the optional text 
message and the green banner on the Login page.

For security reasons, for example, you may not want the instrument IP address to display 
during login. To hide the banner, deselect the Show device banner on Login page checkbox. 
See Figure 8-9 on page 8-10. After changing the Show/Hide setting, click OK in the Banner 
Visibility message box. You may need to scroll the browser page to bring the message box into 
view.

The factory default is to show the banner. Note that this device option only affects the Login 
page. Figure 8-10 illustrates the Login page with no banner. 

Note
Some operating systems, such as iOS, do not support a user-accessible file 
system. Consequently, the download function is not possible if your control device 
is an Apple iPhone, for example.

Figure 8-10. Login Page with Optional Text and No Banner
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To add a disclaimer or any other message to the Login page, enter the appropriate text in the 
text box under the Device Options section of the Device Management page, then click Save. 
See Figure 8-9 on page 8-10. Click OK in the update status message box (Figure 8-11). You 
may need to scroll the browser page to bring this message box into view. 

Figure 8-10 on page 8-11 shows an example of optional text on the Login page. To remove the 
message, delete it from the Disclaimer Text box on the Device Management page and click 
Save, then OK.

Instrument Name

The instrument name function is the same whether you are logged in as Administrator or as a 
regular user. Refer to “Instrument Name” on page 8-9.

Session Time

The session time is set in the same manner, whether you are logged in as Administrator or as 
a regular user. Refer to “Session Time” on page 8-9.

Logout

Exits Web Remote Control and displays the Login page. To start a new session, enter the 
password if required, then select the session time and click Login. 

Figure 8-11. Disclaimer Text Update Status

Note
If you close the Web Remote Control browser window without logging out, there 
may be a slight delay before the instrument is released. During this time, 
connection attempts by other users will fail.
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Appendix A — Related Documents

A-1 Introduction 
This appendix provides a list of supplemental documentation for Spectrum Master features 
and options. These measurement guides are available as PDF files from the Anritsu Web site. 
To determine the spectrum analyzer firmware version in your instrument, refer to submenu 
key description for “Status” on page 5-3.

Options 

Table A-1. Analyzers and Analyzer Options (1 of 2)

Spectrum Master Feature (Required Option)
Related Document 
(Part Number)

All Spectrum Master Instruments

Important Product 
Information, Compliance 
and Safety Notices
(10100-00065)

Spectrum Analyzer (709, 713, 720, 732, or 743)
PIM Hunting
IQ Waveform Capture (24)
Interference Analyzer (25)
Channel Scanner (27)
Zero-Span IF Output (89)
Gated Sweep (90)
Coverage Mapping (431)
EMF Measurements (444)
AM/FM/PM Analyzer (509)

Spectrum Analyzer 
Measurement Guide 
(10580-00349) 

Tracking Generator (809, 813, or 820)
Tracking Generators
Measurement Guide
(10580-00339)

High-Accuracy Power Meter (19)
Power Meter 
Measurement Guide 
(10580-00240)

IEEE 802.16 WiMAX Fixed and Mobile Signal Analyzer (885)
WiMAX Signal Analyzer 
Measurement Guide 
(10580-00236)

CDMA/EV-DO Measurements (884)
3GPP2 Signal Analyzer 
Measurement Guide 
(10580-00235)
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GSM/GPRS/EDGE Signal Analyzer (880)
W-CDMA/HSPA+ Signal Analyzer (881)
TD-SCDMA/HSPA+ Signal Analyzer (882)
LTE/LTE-A (FDD and TDD) Signal Analyzer (883)
LTE 256 QAM Demodulation Measurement (886)
NB-IoT Analyzer (887)

3GPP Signal Analyzer 
Measurement Guide 
(10580-00234)

Table A-1. Analyzers and Analyzer Options (2 of 2)

Spectrum Master Feature (Required Option)
Related Document 
(Part Number)
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Related Documents 

A complete suite of PC Tools for Anritsu Handheld RF Instruments is available for download:

  anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box 

Table A-2. Related Documents

Document Description Part Number

Performance Specifications
Spectrum Master Technical Data Sheet

11410-00646

Product Brochure 11410-00647

Programming Manual 10580-00341

Maintenance Manual 10580-00342

PIM Analyzer (requires PIM Master MW82xxA) 10580-00280

EMF Measurement Guide (Option 444) 10580-00455

http://www.anritsu.com/en-US/test-measurement/support/technical-support/handheld-tools-tool-box
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Appendix B — Secure-Environment 
Workplace

B-1 Introduction 
This section describes Option 7 (Secure Data Storage) and Frequency Blanking, types of 
memory in the Spectrum Master, how to delete stored user files in internal memory, and 
recommended usage in a secure-environment workplace.

B-2 Option 7, Secure Data Storage 
Option 7, Secure Data Storage, sets the instrument to allow saving information only to an 
external USB flash drive. Saving to the internal memory is disabled. When Option 7 is 
installed, it is effective immediately and cannot be turned off. In order to turn off Secure Data 
Storage, the option must be removed from the instrument by a service center. 

Frequency Blanking 

Option 7 allows you to hide the displayed frequency values. Frequency values displayed on 
the screen and menus are replaced with ##.####. To enable frequency blanking press the 
Shift key, then the System (8) key. Press the System Options submenu key, then the Reset 
submenu key. Press the Frequency Blanking submenu key so that On is underlined. Setting 
Frequency Blanking back to Off will preset the instrument to factory default settings. 

After frequency blanking is enabled the instrument user is not able to restore the frequency 
readouts. Following is a list of the security measures that have been taken to protect the 
frequency information after Frequency Blanking is turned on.

1. Turning off frequency blanking presets the instrument (and the frequencies) to the 
factory default settings.

2. Turning off the instrument presets the instrument to the factory default settings and 
turns off frequency blanking.

3. Presetting the instrument turns off frequency blanking and restores the factory default 
settings.

Caution  

Note that even with Option 7 enabled, operating parameters (such as frequency 
range and power level that are set by the user) remain stored in the 
Spectrum Master EEPROM when the instrument is turned off. These parameters 
can be erased, however, via a Master Reset operation, as described in “Erase All 
User Files in Internal Memory” on page B-3.



B-3 Remote Access Password Secure-Environment Workplace

B-2 PN: 10580-00340  Rev. R MS2720T UG

4. Option 7 is designed to ensure that user files and calibration files cannot be stored in 
the internal memory of the instrument. 

B-3 Remote Access Password
The purpose of the password is to protect the Spectrum Master from unauthorized access. 
Connecting to the instrument via Master Software Tools (v2.21.1 or later), Wireless Remote 
Tools (WRT), or the Web Remote Control browser interface will require the set password.

B-4 Spectrum Master Memory Types 
The instrument contains non-volatile disk-on-a-chip memory, EEPROM, and volatile DRAM 
memory. The instrument does not have a hard disk drive or any other type of volatile or 
non-volatile memory.

Disk-On-A-Chip (DOC): DOC is used for storage of instrument firmware, factory calibration 
information, user measurements, setups, and .jpg screen images. User information stored on 
the DOC is erased by the master reset process described below.

EEPROM: This memory stores the model number, serial number, and calibration data for the 
instrument. Also stored here are the user-set operating parameters such as frequency range. 
During the master reset process, all operating parameters stored in the EEPROM are set to 
standard factory default values.

RAM Memory: This is volatile memory used to store parameters needed for the normal 
operation of the instrument along with current measurements. This memory is reset 
whenever the instrument is restarted.

External USB Flash Drive (not included with the instrument): This memory may be selected 
as the destination for saved measurements and setups for the instrument. The user can also 
copy the contents of the internal disk-on-chip memory to the external flash memory for 
storage or data transfer. The external Flash USB can be reformatted or sanitized using 
software on a PC.

Refer to Chapter 4, “File Management” for additional information on saving and copying files 
to the USB flash drive.

Warning

Note that when Frequency Blanking is turned on, user files can still be stored and 
saved to an external USB drive, and that frequency information is not blanked in 
those files. Also, frequency information is not blanked from the SCPI commands 
that are used to remotely control the instrument. 
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B-5 Erase All User Files in Internal Memory
Perform a Master Reset:

1. Turn the instrument on.

2. Press the Shift button, then the System (8) button.

3. Press the System Options submenu key.

4. Press the Reset key, then the Master Reset key.

A message box will be displayed to warn the user that all settings will be returned to 
factory default values and all user files will be deleted. This is a standard file deletion 
and does not involve overwriting existing information.

5. Press the ENTER button to complete the master reset.

6. The instrument will reboot and the reset is complete.

B-6 Recommended Usage in a Secure Environment
Set the instrument to save files to the external USB Flash drive:

1. Attach the external Flash drive and turn the instrument on.

2. Press the Shift button, then the File (7) button.

3. Press the Save submenu key.

4. Press the Change Save Location submenu key, then select the USB drive with the 
rotary knob, Up/Down arrow keys, or the touch screen.

5. Press the Set Location submenu key.

The external USB drive is now the default location for saving files.

Note

Not all USB drives are compatible with the instrument. Many drives come with a 
second partition that contains proprietary firmware. This partition must be 
removed. Only one partition is allowed. Refer to the individual manufacturer for 
instructions on how to remove it. Some drives can be made to work by reformatting 
them using the FAT32 format.
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Appendix C — Error Messages

C-1 Introduction 
This chapter provides a list of information and error messages that could be displayed on the 
MS2720T. If any error condition persists, contact your local Anritsu Service Center 
(http://www.anritsu.com/contact-us).

C-2 Self Test or Application Self Test Error Messages 

Overall Status FAILED 

One or more elements of the System or Application Self Test has failed. Refer to the other 
pass fail tests listed below to determine which specific test failed.

Lock Test FAILED

One or more Phase Lock Loops Failed to properly achieve Lock Status. Ensure that the 
battery level is adequate for operation or that temperature is within acceptable limits. Reset 
to factory defaults with either Factory Reset (ESC+ON), or MASTER RESET (System+ON). 
Caution: Use of MASTER RESET (System+ON), will erase all user saved setups and 
measurement traces and return the unit to a fully Factory Default condition. If the error 
persists, contact your Anritsu Service Center.

Over Power FAILED (MS2720T-0709)

RF Power applied to the input connector is too high. Remove or reduce the input power or add 
additional attenuation. Sometimes out of band frequencies may be present that can cause an 
Over Power Error. In highly rich RF environments it may be necessary to add an external 
band pass filter to reduce unwanted interference. See the accessories section for a list of 
available band pass filters from Anritsu. Out of band frequencies can often be detected by 
increasing the Span to maximum in the peak detect mode of operation. If the error persists, 
contact your Anritsu Service Center.

Over Power Start FAILED

RF Power applied to the input connector is too high at turn on. See Over Power FAILED error 
above.

Mixer Saturation:  Increase Attenuation

Too much power applied with too little Attenuation. Increase attenuation. Sometimes even 
out of band frequencies may be present that would cause a Mixer Overdrive Error. In highly 
rich RF environments it may be necessary to add an external band pass filter to reduce 
unwanted interference. See the accessories section for a list available band pass filters from 
Anritsu. Out of band frequencies can often be detected by increasing the SPAN to maximum 
in peak detect mode of operation. If the error persists, contact your Anritsu Service Center.

http://www.anritsu.com/contact-us
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C-3 Operation Error Messages 

Fatal Error

Usually caused by a failure to communicate with one section or another. Sometimes resolved 
by restarting the unit or by Factory Reset (ESC+ON), resetting of the unit. Under extreme 
cases the use of MASTER RESET (System+ON), may resolve the issue. Caution: Use of 
MASTER RESET (System+ON), will erase all user saved setups and measurement traces and 
return the unit to a fully Factory Default condition. If the error persists, contact your Anritsu 
Service Center.

Trace not saved. Please wait for complete sweep and try again.

Attempted to save a measurement trace before the sweep had completed at least once. Wait 
for at least one complete sweep and try to save again. 

Measurement not valid in Zero Span

Attempt was made to make an automated measurement that requires more than ZERO 
SPAN to accomplish. An example would be Occupied Bandwidth measurement.

The Freq range of the Antenna is invalid for this setup. Please select another Antenna

Choose a start and stop frequency that is within the defined frequency range for the selected 
antenna compensation table. See also Master Software Tools for creation and Upload of 
Antenna correction files.

Unable to add additional limit points. 41 is the maximum.

Attempted to add an additional limit line point beyond the maximum number of allowed 
points.

Use Demod type USB or LSB to use Beat Frequency Osc  

An attempt to use the Beat Frequency Oscillator while not in Upper or Lower Sideband 
Demodulation mode.

Trace A/B/C has no data to view

Attempt to turn on or view a trace that has never had data recalled into this trace location.

Locking to External Ref failed; Lock attempt Failed

Switching from an internal frequency reference to the external reference has failed. Verify 
that the correct external reference frequency value has been selected from the list of valid 
external reference frequencies. Verify that the level of the external reference frequency is at 
least 1 Vp-p.
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Operation not Permitted in Recall Mode

Attempted to perform an operation on a recalled trace. Many operations are valid only on a 
live or active trace.

Cannot change scale in Linear mode

Linear display mode of operation does not support a scaling change in the same manner as 
the Log display mode.

Cannot turn on delta marker because Ref Marker is a counter Marker

Delta markers cannot be enabled unless the primary marker is NOT a counter Marker. Turn 
off the Counter Marker mode of marker operation to use Delta Marker.

Triggering only available in Zero Span

External triggering can only be used while the SPAN is set to 0 (zero).

Cannot change Modes for Recalled/Inactive Traces

Detection modes or other elements such as RBW/VBW, averaging, and so forth, cannot be 
altered on a recalled trace. The trace is displayed with the same parameters in which it was 
saved.

Cannot change average for Recalled/Inactive Traces 

Cannot set Number of Averages on a recalled trace. The trace is displayed with the same 
parameters in which it was saved.

Reference LVL Cal is OFF

Factory Calibration is OFF. Ensure that the battery level is adequate for operation or that 
the temperature is within acceptable limits. Reset to factory defaults with either Factory 
Reset (ESC+ON), or MASTER RESET (System+ON). Caution: Use of MASTER RESET 
(System+ON), will erase all user saved setups and measurement traces and return the unit to 
a fully Factory Default condition. If the error persists, contact your Anritsu Service Center.

IF Cal is OFF

Factory Calibration is OFF. Ensure that the battery level is adequate for operation or that 
the temperature is within acceptable limits. Reset to factory defaults with either Factory 
Reset (ESC+ON), or MASTER RESET (System+ON). Caution: Use of MASTER RESET 
(System+ON), will erase all user saved setups and measurement traces and return the unit to 
a fully Factory Default condition. If the error persists, contact your Anritsu Service Center.

Cannot set Delta Mkr Freq to Demod Freq 

Marker to Demod frequency is only available with a primary marker as the selected marker.

Fan Failure     

The system has determined that the fan should be running due to the internal temperature of 
the unit, but cannot detect that the fan is actually running.
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It is important to keep the fan inlet and exhaust ports clear of obstructions. The cooling fan 
will vary the speed in relation to the internal temperature of the instrument. The fan will 
turn on at low speed when the internal temperature of the instrument reaches 44 ºC, and will 
increase the fan speed to maximum at 54 ºC. As the internal temperature of the instrument 
decreases, the fan will reduce speed until the temperature reaches 39 ºC, at which point the 
fan will turn off.

High Temp Warning

The internal temperature has reached an excessive level, 85ºC. Verify that the ventilation 
openings are unobstructed and that the fan is running. Internal temperatures may be 
manually verified by using the SELF TEST function. Turn off the unit and allow the 
temperature to cool down. If the fault is not resolved and if the internal temperature reaches 
90ºC, then a countdown of 10 seconds will begin to give the user a chance to save the current 
setup before it will turn itself off (before internal temperatures can cause any damage). If the 
error persists after removing any obstructions and allowing the unit to cool, then reset to the 
factory defaults with either Factory Reset (ESC+ON). Caution: Use of MASTER RESET 
(System+ON), will erase all user saved setups and measurement traces and return the unit to 
a fully Factory Default condition. If the error persists, contact your Anritsu Service Center.

Copy failed. Please check External USB Memory

Attempt to copy user saved data to the external USB Flash drive has failed. Do not attempt to 
remove or power down the unit before the copy has completed. Be sure that the USB memory 
device is not already full and that it is fully inserted into the USB connector.

PLL Lock Fail

Phase Lock Loop failed to lock. 

Trace not saved. Please wait for complete sweep and try again.

Attempted to save a measurement trace before the sweep had completed at least once. Wait 
for at least one complete sweep and try to save again.

Figure C-1.  Fan Speed versus Temperature
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Appendix D — LAN and DHCP

D-1 Introduction 
This appendix describes network connections for the Spectrum Master. 

D-2 LAN Connection
The RJ-45 connector is used to connect the instrument to a local area network. Integrated 
into this connector are two LEDs. The amber LED shows the presence of a 10 Mbit/s LAN 
connection when on, and a 100 Mbit/s LAN connection when off. The green LED flashes to 
show that LAN traffic is present. 

D-3 Ethernet Configuration 
The instrument IP address is set by pressing the Shift key, then the System (8) key followed 
by the System Options submenu key and the Ethernet Config submenu key. The instrument 
Ethernet address can be set automatically using DHCP, or manually by entering the static IP 
address, gateway address, and subnet mask.

Dynamic Host Configuration Protocol (DHCP) is an Internet protocol that automates the 
process of setting IP addresses for devices that use TCP/IP, and is a common method of 
configuring a device for network use.
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Ethernet Menu  

Key Sequence: Shift, System (8) > System Options > Ethernet Config   

Type
Manual DHCP: Press the Type submenu key to select whether the IP 
address will be entered manually or will be supplied automatically by a 
network DHCP server. See Figure D-2 and Figure D-3 on page D-3.

If Manual is selected, use the submenu keys or the Left/Right arrow keys to 
select the field that is to be modified in the Ethernet Editor dialog. Use the 
numeric keypad, the Up/Down arrow keys, or the rotary knob to enter the 
values. Press Enter to accept the changes, or press the Esc key to exit 
Ethernet Configuration without making changes.

If DHCP is selected with the Type key, press Enter to close the Ethernet 
Editor dialog, then press Shift, System, and Status to view the IP address 
assigned by the DHCP server. Press Esc to close the Status screen.

Field
IP G-Way Sub: Press this submenu key to select the desired Internet 
Protocol Property to be edited.

First Octet: Moves the cursor to the leftmost column of the selected IP 
properties field.

Second Octet: Moves the cursor to the second column from the left of the 
selected IP properties field.

Third Octet: Moves the cursor to the third column from the left of the 
selected IP properties field.

Fourth Octet: Moves the cursor to the fourth column from the left of the 
selected IP properties field.

Figure D-1. Ethernet Menu

Ethernet

Type

Manual         DHCP
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IP     G-Way    Sub
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Figure D-2. Setting IP Address Manually

Figure D-3. IP Address Assigned Using DHCP
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DHCP 

DHCP stands for Dynamic Host Configuration Protocol. It is a protocol that allows a server to 
dynamically assign IP addresses to devices that are connected to the network. Most networks 
include a DHCP server to manage IP addresses.

When using DHCP, no setup is required to lease and use a dynamic IP address. In a dynamic 
IP operation, the IP address in use may change from use to use. The DHCP server hands out 
IP addresses on a first come, first served basis. As soon as the device is disconnected from the 
network, the IP address that it was using becomes available to lease to the next unit that 
requests an IP address. Normally, some amount of lag time is present on the DHCP server 
end, so if the device is connected again reasonably soon, then it may end up with the same 
address. 

When a DHCP server is not available, a static IP address can be used. A static IP address is a 
fixed address. After being set, it will always remain the same, and care must be taken to not 
conflict with other equipment on the network.

When using a static IP address on an established network, always request the static IP 
address from the network administrator. Randomly choosing a static IP address on an 
established network may result in duplicate IP addresses or other conflicts.

Three parameters must be set prior to using a static IP address:

IP Address  

This is the static IP address on the network. Static IP addresses are necessary when you have 
no physical access to the instrument, or any other way to determine the instrument’s IP 
address assigned by the DHCP server.

Default Gateway   

Often when a static IP address is assigned, a default gateway is also identified. If the default 
gateway is unknown, then type in the static IP address so that the static IP address and 
default gateway are the same number.

Subnet Mask   

This parameter is usually extracted from the static IP address based on the class of the 
address and determines the destination of any broadcast messages that might be sent from 
the instrument. It can be customized if necessary. The subnet mask may also be provided 
with the static IP address.

Example 1

In this example, a static IP address has been chosen because no network DHCP service is 
available. The instrument is connected to the network port on the PC with a crossover 
Ethernet cable (not included). This is also referred to as Direct Connect:

IP Address: 10.0.0.2

Default Gateway: 10.0.0.2

Subnet Mask: 255.255.0.0
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Example 2

In this example, the static IP address has been assigned with an associated gateway and 
subnet mask:

IP Address: 153.56.100.42

Default Gateway: 153.56.100.1

Subnet Mask: 255.255.252.0

D-4 ipconfig Tool 
A few tools that are built into the Microsoft Windows operating system can assist in making 
some determinations about the network to which the PC is connected. Typing ipconfig at a 
command prompt produces a display of information about the in-use parameters of the PC 
and its network connection. Following is an example of the typical results expected: 

Y:\>ipconfig

Windows 2000 IP Configuration

Ethernet adapter Local Area Connection:

Connection-specific DNS Suffix. : us.anritsu.com

IP Address. . . . . . . . . . . . : 172.26.202.172

Subnet Mask . . . . . . . . . . . : 255.255.252.0

Default Gateway . . . . . . . . . : 172.26.200.1

Note
The ipconfig display does not report whether the information is from a DHCP 
server or from a static IP setup.
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D-5 Ping Tool  
Another tool that can find out if a selected IP address is already on the network is ping. Ping 
is a harmless way to determine if an address is found on the network, and (if it is found) to 
receive a reply. Basically, the ping function sends out a request to a specific address to 
determine if a computing device is connected to the network at that address. If a valid 
connection is found, then a copy of the signal (that was sent) is returned. If a connection is not 
found, then the response is “request timed out”, which means that no reply was received from 
that IP address. 

Y:\>ping 172.26.202.172

Pinging 172.26.202.172 with 32 bytes of data:

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Reply from 172.26.202.172: bytes=32 time<10ms TTL=128

Ping statistics for 172.26.202.172:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),

Approximate round trip times in milliseconds:

Minimum = 0 ms, Maximum = 0 ms, Average = 0 ms
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Appendix E — Glossary of Terms

E-1 Introduction
The following terms are related to this product and technology.

E-2 Glossary of Terms
Adapter : A fitting that supplies a passage between two sets of equipment when 

they cannot be directly interconnected. 

 

Adaptive Array
Antenna : Adaptive array antenna is a type of advanced ’smart’ antenna 

technology that continually monitors a received signal and dynamically 
adapts signal patterns to optimize wireless system performance. The 
arrays use signal processing algorithms to adapt to user movement, to 
changes in the radio-frequency environment, and to multi-path and 
co-channel interference. 

 

ADC : Analog-to-Digital Converter (ADC, A/D or A to D) is an electronic device 
that converts continuous signals to discrete digital numbers. The 
reverse operation is performed by a digital-to-analog converter (DAC). 
ADC can uniquely represent all analog input values within a specified 
total input range by a limited number of digital output codes. Refer also 
to DAC. 

 

Analog System : An Analog system uses an analog transmission method to send voice, 
video and data-using analog signals, such as electricity or sound waves, 
that are continuously variable rather than discreet units as in digital 
transmissions. Mobile analog systems include AMPS, NMT and 
ETACS. 

 

Analog
Transmission : Analog Transmission refers to signals propagated through the medium 

as continuously varying electromagnetic waves. 

 

Antenna Gain : Antenna gain, also known as antenna directivity, is the relative gain of 
the main beam of an antenna pattern to a reference antenna, usually an 
isotropic or standard dipole. Antenna Gain is the effectiveness of a 
directional antenna expressed as the ratio of input power of the 
directional antenna to input power of an isotropic radiator to provide 
the same field strength in the desired direction. Sometimes related to a 
dipole antenna. 



E-2 Glossary of Terms Glossary of Terms

E-2 PN: 10580-00340  Rev. R MS2720T UG

 

Attenuation : Attenuation refers to decreasing in signal magnitude between two 
points. These points may be along a radio path, transmission line or 
other devices. 

 

Attenuator : Attenuator is a device specifically designed to decrease the magnitude 
of a signal transmitted through it. 

 

Average power : Average power is the peak power averaged over time and is usually 
applied to pulsed systems where the carrier power is switched on and 
off. 

 

Backhaul : In wireless technology, backhaul refers to transporting voice and data 
traffic from a cell site to the switch. 

 

Band Pass Filter : A Band Pass Filter is a radio wave filter with a specific range of 
frequencies in which it is designed to pass. It rejects frequencies outside 
the pass-band range. A resistor-inductor-capacitor circuit is an example 
of a Band Pass Filter. 

 

Bandwidth : Bandwidth usually identifies the capacity of a circuit or amount of data 
that can be sent through a given circuit. It may be user-specified in a 
PVC. It is an indication of the amount of data that is passing over a 
medium. Also, bandwidth is the portion of the frequency spectrum 
required to transmit desired information. Each radio channel has a 
center frequency and additional frequencies above and below this 
carrier frequency which is used to carry the transmitted information. 
The range of frequencies from the lowest to the highest used is called 
the bandwidth. 

 

BER : Bit Error Rate or Bit Error Ratio (link quality specification/testing) 
(BER) is a measure of transmission quality. The ratio of error bits to the 
total number of bits transmitted. A bit error rate of 10-6 refers to an 
average of one error per million bits. It is generally shown as a negative 
exponent, (for example, 10-7 which means 1 out of 107 bits are in error 
or 1 out of 10,000,000 bits are in error). Bit Error Rate is the fraction of 
a sequence of message bits that are in error. 

 

BERT : Bit Error Rate Test/Tester (BERT) is a test that gauges the quality of 
the T1 or digital line. By sending a known pattern to another device 
across the span, the far end device can compare incoming pattern to its 
own, thereby indicating bit errors on the line. 
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Broadband : Broadband refers to telecommunication that provides multiple channels 
of data over a single communications medium, typically using some 
form of frequency or wave division multiplexing. It is a service or 
system requiring transmission channels capable of supporting rates 
greater than the Integrated Services Digital Network (ISDN) primary 
rate. 

 

Coaxial Cable : Coaxial Cable (Coax) is a type of electrical communications medium 
used in the LAN environment. This cable consists of an outer conductor 
concentric to an inner conductor, separated from each other by 
insulating material, and covered by some protective outer material. 
This medium offers large bandwidth, supporting high data rates with 
high immunity to electrical interference and a low incidence of errors. 
Coax is subject to distance limitations and is relatively expensive and 
difficult to install. 

 

CW : Continuous Wave (CW) 

 

DANL : Displayed Average Noise Level (DANL): Displayed average noise level 
is sometimes confused with the term Sensitivity. While related, these 
terms have different meanings. Sensitivity is a measure of the 
minimum signal level that yields a defined signal-to-noise ratio (SNR) 
or bit error rate (BER). It is a common metric of radio receiver 
performance. Spectrum analyzer specifications are always given in 
terms of the DANL. One of the primary uses of a spectrum analyzer is to 
search out and measure low-level signals. The limitation in these 
measurements is the noise generated within the spectrum analyzer 
itself. This noise, generated by the random electron motion in various 
circuit elements, is amplified by multiple gain stages in the analyzer 
and appears on the display as a noise signal. On a spectrum analyzer, 
this noise is commonly referred to as the Displayed Average Noise 
Level, or DANL 1. While there are techniques to measure signals 
slightly below the DANL, this noise power ultimately limits our ability 
to make measurements of low-level signals. 

 

DAS : Distributed Antenna System (DAS) is a network of antenna nodes that 
are used to provide wireless service in a limited area or in a building. A 
DAS may be indoors or outdoors. Such an antenna or series of antennas 
can be connected via coaxial cable, leaky feeder, or optical fiber link. 
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dB : Decibel or deciBel (dB) is a unit for measuring relative power ratios in 
terms of gain or loss. The units of dB are expressed in terms of the 
logarithm to base 10 of a ratio and typically are expressed in watts. For 
example, a -3dB loss indicates a 50% loss in power; a +3dB reading is a 
doubling of power; 10 dB indicates an increase (or a loss) by a factor of 
10; 20 dB indicates an increase (or a loss) of a factor of 100; 30 dB 
indicates an increase (or a loss) by a factor of 1000. 

 

dBc : Decibels referenced to the carrier (dBc) is a technique for expressing a 
power measurement in logarithmic form using the carrier power as a 
reference. The units are used to describe how far down signals and noise 
are relative to a known signal. Typical use of this term is to describe 
spurious signals and noise compared to a desired transmit signal. 

 

dBm : dBm is a decibel value referenced to a milliWatt (dBm). This is a 
technique for expressing a power measurement in logarithmic form 
using 1 mW as a reference. dBm is a decibel ratio (log 10) of Watts (W) 
to one milliwatt (1mW). dBm, therefore, represents absolute power. 

 

DHCP : Dynamic Host Configuration Protocol (DHCP) 

 

DSP : Digital Signal Processing (DSP) 

 

EMI : ElectroMagnetic Interface (EMI): EMI refers to signals that are 
generated and radiated by an electronic device and that cause 
interference with radio communications, among other effects. MI is the 
interference by electromagnetic signals that can cause reduced data 
integrity and increased error rates on transmission channels. 

 

Flash Memory : Flash memory is a non-volatile solid state storage device that is 
packaged as a chip. It can be electrically erased and reprogrammed. T is 
primarily used in memory cards, USB flash drives, MP3 players, and 
solid-state drives for general storage and transfer of data between 
computers and other digital products. Is a specific type of EEPROM 
(electrically erasable programmable read-only memory) that is erased 
and programmed in large blocks. 

 

Gain : Gain refers to the ratio of the output amplitude of a signal to the input 
amplitude of the signal. This ratio typically is expressed in dB. He 
higher the gain, the better the antenna receives or transmits, but also 
the more noise it includes. 
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GPS : The Global Positioning System (GPS) is a space-based global navigation 
satellite system (GNSS) that provides reliable location and time 
information in all weather and at all times when and where an 
unobstructed line of sight is available to four or more GPS satellites. 
The system is maintained by the United States government and is 
freely accessible by anyone with a GPS receiver. The Global Positioning 
System is making it possible for people using ground receivers to 
determine their geographic location within 10 to 100 meters. The 
satellites use simple mathematical calculations to broadcast 
information that is translated as longitude, latitude, and altitude by 
Earth-based receivers. 

 

NF : Noise Figure (NF) is a measure of degradation of the signal-to-noise 
ratio (SNR) that is caused by components in a radio frequency (RF) 
device. The noise factor (F) of a system is defined as the signal-to-noise 
ratio of the input power of the system divided by the signal-to-noise 
ratio of the output power of that system. F (the noise figure) is defined 
as the decibel value of the noise factor. = 10log (F) where log uses the 
base 10, or common log. T s formula is valid only then the input 
termination is at standard noise temperature. 

 

OBW : Occupied Bandwidth (OBW) is a measure of the bandwidth containing 
99% of the total integrated power of the transmitted spectrum, centered 
on the assigned channel frequency. Interference to other channels or to 
other systems can occur if OBW is too large. 

 

OTA : Over The Air (OTA): OTA refers generally to any transfer of information 
or signal that takes place in a wireless environment, rather than using 
a wired connection. OTA is usually used in connection with a standard 
defining the provisioning of mobile devices and applications, such as 
downloading or uploading content or software, and commonly used in 
conjunction with the Short Messaging Service (SMS). SMS OTA 
Messages contain information that is used to configure the settings of a 
WAP browser in a mobile phone (refer to SMS and WAP). 

 

:
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see DHCP
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